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Capitulo 1

Introducao

Este € um curso curto de «Introducdo a Redes e Linux». Foi escrito para os alunos
do primeiro ano das licenciaturas em Engenharia Electrotécnica e Engenharia Infor-
matica na Faculdade de Engenharia da Universidade do Porto (FEUP); no entanto, a
maior parte do contetudo podera ser util para qualquer utilizador dos sistemas infor-
maticos da FEUP e inclusivamente para pessoas de outras instituices que precisem
de uma introducao ao Linux e aos sistemas distribuidos.

1.1 O sistema operativo Linux

Linux é um «clone» do sistema Unix, com a caracteristica de ser o primeiro sistema
completo totalmente livre (0 seu codigo fonte esta disponivel para ser estudado e
modificado por qualquer pessoa, e esta protegido legalmente para garantir que sem-
pre permanecera livre) e desenvolvido por um grande grupo de programadores vo-
luntarios em todo o mundo. Tecnicamente, Linux € apemagkeodo sistema, que
foi originalmente escrito por Linus Torvalds em 1991, mas uma vez desenvolvido o
nacleo foi possivel compilar um grande conjunto de aplicagdes e programas livres
gue formam o que hoje em dia € conhecido genericamente como Linux. Muitas das
aplicacdes incorporadas no sistema formam parte do sistema GNU, que comecgou a
ser desenvolvido desde 1984 e € um dos pioneiros no movimento do software livre.

Actualmente o sistema GNU/Linux pode ser instalado em muitas plataformas
informaticas diferentes, € bastante estavel e a sua eficiéncia € comparavel (se nédo
melhor) do que outros sistemas comerciais. Os criticos do movimento do software
livre argumentam que por ser desenvolvido por voluntarios ndo tem a garantia e
apoio necessarios para os seus utilizadores, mas na pratica o que tem acontecido é
gue um grande grupo de programadores com talento tém sido atraidos pela liberdade
de desenvolvimento do software livre, e hoje em dia € facil obter ajuda a través de
listas de correio ou de manuais que também séo distribuidos livremente.

O aumento da sua popularidade coloca-o entre 0s sistemas operativos mais usa-
dos em todo o mundo, tornando-o num possivel lider a médio prazo. O facto de o
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préprio comércio se estar a re-orientar, o incrivel nimero de utilizadores existentes,
e a sua fiabilidade, é o suficiente para finalmente se criar toda uma nova dimenséo.

1.2 Aplicacgoes e Distribuictes

A nivel de aplicativos para Linux existe, neste momento, um namero incrivelmente
grande e vasto em todas as areas. Processadores de texto, folhas de calculo, apli-
cacoes para a Internet, programas para investigacdo matematica e cientifica, mul-
timédia e entretenimento. Em média, cinquenta novas aplicac@ipdatessao
lancados diariamente, e a maior parte deles séo gratuitos. Por outro lado, o Linux
(tal como o Unix) é um sistema de rede desde a sua nascenca. A seguranca e o
suporte de multi-utilizadores ndo sado apenas mais uma capacidade, mas sim parte
integrante do sistema. Esta € razdo suficiente para muitos servidores correrem sobre
Unix/Linux.

Do ponto de vista empresarial, além de ser mais barato do que ter de comprar,
digamos, 100 ou 200 licencas de um sistema comercial, € também altamente facil
construirclustersde alta performance e fiabilidade. Se tomarmos em conta que al-
gumas empresas possibilitam também suporte técnico, estamos perante um sistema,
acima de tudo, rentavel.

A nivel de entretenimento, a verdade é que o Linux € mais um sistema técni-
co e profissional do que propriamente uma boa «consola de jogos», como alguns
sistemas comerciais. No entanto, esta barreira atenua dia-a-dia tornando-o inques-
tionavelmente tdo bom no entretenimento quanto ele é nas suas aplicacdes mais
«Sérias».

O sistema Linux pode ser obtido em forma ja compilada e com um grande nu-
mero de programas, formando untatribuicdo. Existem varias boas distribuicdes
de Linux (SUSE, SlackWare, Debian, RedHat, Caldera...), tendo cada uma as suas
vantagens e desvantagens. Algumas apostam em trazer inUmeras aplicacdes, outras
em sendo minimalistas. Algumas gostam de automatizacao (para novos utilizado-
res), outras mais orientadas para veteranos no assunto. Mas no fim de tudo, todas
se baseam no mesmo nucledk@nel). Cabe a cada utilizador decidir qual gosta
mais...

1.3 O Linux e outros sistemas

Existem duas formas de preservar o seu sistema operativo antigo, apés a instalagéo
do Linux, e até mesmo usa-lo se for necessario. A forma mais simples e eficaz
€ instalar um pequeno programa, que normalmente vem com as distribui¢cdes, que
guestiona o utilizador sobre o sistema operativo a usar quando o sistema arranca.
Isto permite-lhe assim ter o seu sistema antigo intacto numa particdo diferente, sem
ter o minimo de problemas (o0s outros sistemas operativos nem saberdo que o Linux
est4 instalado!).
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A outra forma é usando um emulador ou simulador. Podemos mencionar o
Wine um simulador que permite correr algumas aplicacdes do sistema Windows,
ou até mesmo ¥MWare(comercial) que virtualiza completamente uma maquina,
permitindo assim correr qualquer sistema operativo sobre ela.

1.4 Documentacéao

Normalmente todas as distribuicdes trazem documentacao (pelo menos a suficiente
para a instalar). No entanto, existem as ultimas vers6dsQI&TO’s (Tutoriais

sobre instalacdo de hardware, configuracdo de inimeros programas, etc.) e docu-
mentacgao variada em diversegesna Internet. Um deles élonux Documentation
Project (http://www.linuxdoc.org), 0 qual possui livros inteiros e artigos em forma-

to electronico (Postscript, PDF, HTML, puro Texto e fontes LaTeX) abrangendo
diversos assuntos com respeito ao Linux e suas aplicacdes, desde um simples «Ma-
nual de Instalagdo», até ao «Guia do Programador». Como pode verificar, o Linux
nao prima pela falta de documentacgao.

Na FEUP tem inimeros locais aos quais se pode dirigir para tirar davidas so-
bre Linux. O Reino Linux € um grupo de utilizadores de Linux da FEUP que
pode ajudar-lhe em qualquer questdo e ao qual se pode dirigir através da pagi-
na: http://reinolinux.fe.up.pt. O Reino Linux gere também uma lista de correio
electronico Cortes) onde séo respondidas perguntas sobre Linux. Muitas das du-
vidas que possa ter podem ja ter resposta na pagina da rede Linux do DEEC -
http://deec00ws29.fe.up.pt - Ou noarquivo das cortes
(http://reinolinux.fe.up.pt/cortes/maillist.html).


http://www.linuxdoc.org
http://reinolinux.fe.up.pt
http://deec00ws29.fe.up.pt
http://reinolinux.fe.up.pt/cortes/maillist.html
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Capitulo 2

Ambiente grafico

Tradicionalmente, o Unix associa-se a uma série de comandos com nomes dificeis
de lembrar que sao usados num terminal de texto. Essa foi a forma tradicional
como o Unix foi desenvolvido, e continua a ser o modo de operacédo mais rapido e
preferido por pessoas com muita experiéncia, mas existe também o modo gréfico
usando o X que resulta mais facil e agradavel de usar para quem se esta a iniciar no
sistema operativo.

Num ambiente grafico como o X sao disponibilizadas areas de trabalho virtuais.

A gestdo dessas areas de trabalho esta a cargo do gestor de janelas. Normalmente as
varias areas sao configuraveis independentemente, podendo cada uma, por exemplo,
apresentar uma imagem de fundo diferente.

Uma outra peculiariedade do sistema de janelas X, para quem nao esteja fa-
miliarizado com ele, é que os trés botdes do rato (esquerdo, central e direito) sdo
importantes em muitas aplicagdes. Quando o rato tem apenas dois botdes, nor-
malmente «emula-se» um rato com trés botbes, sendo o botdo do meio obtido pela
presséo simultanea dos dois botdes.

2.1 Entrar na maquina

Para se aceder a uma estacao de trabalho Unix é necessario liagiex ou seja,
fornecer a maquina a identificacdo de um utilizador e passwordde autentica-

cdo. Este pode ser feito em modo de texto ou em modo grafico, dependendo da
maneira como a maguina esté configurada. Na FEUP a grande maioria dos sistemas
Unix estédo configurados para fazer a validacao do utilizador em modo grafico.

Num login gréfico € normalmente apresentado um ecrd com uma imagem de
fundo, e uma janela com: um campo para a identificagéo do utilizador, um campo
para a password, e menus variados (Qque mudam conforme o gestgrirgegue
permitem mudar de gestor de janelas, fechar a maquina, recomecar, etc.

Para entrar na maquina basta introduzir ossernameno campo de identifica-
¢éo do utilizador, a supasswordno campo para password escolher o gestor de
janelas desejado e carregar em OK.
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2.2 Gestores de Janelas

2.2.1 KDE
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Figura 2.1: Ambiente de trabalho no KDE.

Arrange icons

Descricao

KDE é um gestor de janelas bastanser-friendly Quem gostar do ambiente grafi-
co do Windows 9x/NT provavelmente gostara deste gestor, devido a sua semelhan-
ca a nivel grafico. O interface é bastante intuitivo permitindo que pessoas novas
ao ambiente trabalhem com eficiéncia e rapidez. Este gestor de janelas usa bastan-
tes recursos de maquina, pelo qual ndo é aconselhavel em maquinas lentas ou com
pouca memoria.

KDE ¢ o gestor de janelas maiser-friendlydisponivel em Linux. E o ideal
para pessoas habituadas a trabalhar em Windows 9x/NT devido a sua facilidade de
utilizacao e semelhanca a nivel grafico. O interface € bastante intuitivo permitindo
gue pessoas novas ao ambiente trabalhem com eficiéncia e rapidez.

Interface

Possui undesktopnde se podem colocar atalhos (1) para aplicacddsves uma
taskbar(2) para comutar facilmente entre as aplicagdes que estao a correr, e uma
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barra de ferramentas (3) para executar as principais aplicacdes mais rapidamente.
Todos os programas podem ser corridos através do menu de aplicacdes (4) acedido
no canto inferior esquerdo na barra de ferramentas. Este gestor de janelas tem ainda
a vantagem de trazer de raiz uma grande quantidade de aplica¢des: calculadora,
editor de texto, jogos varios, editor de imagens, explorador de fractais, compressor
de ficheiros, etc (que podem ser usados também em qualquer outro gestor de janelas
diferente do KDE).

Por omissao existem quatro areas virtuais de trabalho podendo este niumero ser
extendido até oito. A transi¢ao entre os varios ambientes virtuais € feita através de
botbes na barra de aplicacdes (5). Cada ambiente de trabalho pode ser configurado
independentemente com diferentes imagens de fundo, icones e até nomes.

O botéo central e o botéo direito do rato permitem-nos aceder a diferentes me-
nus. Pressionando o central temos acesso a um menu (6) com as aplicacdes a correr
nos varios ambientes de trabalho. O botéo direito, por sua vez, da-nos acesso a um
menu de contexto (7) com opcdes especificas relativas a area onde se encontra o
cursor do rato nesse momento.

Para sair deste gestor de janelas e voltar ao gestlmgde basta executar o
comandd.ogout que se encontra no menu de aplicagdes (4).

Configuracéo

i:IE=N KDE Control Center -0 X
% File Options  Help

EHET Applications

&2 Login Manager

|QOI0r | Other '

Font Size
[G Small  dedium = Large

EHEF

Desktop Standard Font Ihelvetica j
B4 Infarmation
[}% Input Devices Fixed Font Icouner j
EE Keys Default Charset IUse language charset j
—@ Metwark
EJ—"’;ﬁ Sound
EHER windows

Help | Default | (0]:9 I Apply Cancel

Y¥ou can configure the look and feel of the File hManager here

Figura 2.2: KDE Control Center.
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A configuracdo do KDE € muito facil e totalmente controlada através de uma
Unica aplicacdo denominada «KDE Control Center». Aqui pode-se alterar todos os
aspectos do gestor de janelas como a imagem de fundo, o nimero de ambientes de
trabalho e os seus nomes, a lingua utilizada, o gestor de ficheiros, etc. A navegacdo
entre as varias opcoes é facil e rapida devido ao seu esquema em arvore (1) e ao uso
de separadores (2).
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Figura 2.3: Ambiente de trabalho no ICE.

Descricao

O ICE, segundo o seu autor, foi criado com o objectivo de fornecer aos utilizado-
res de Linux um gestor de janelas que fosse pequeno, rapido e parecido com 0s
interfaces graficos convencionais. Como tal, € um gestor que ndo traz nenhuma
novidade a nivel de utilizagcdo. O ambiente de trabalho é simples e parecido com
o KDE, nao representando um obstaculo para utilizadores nao familiarizados com
este ambiente.

Interface

A nivel de interface possui um menu de aplicacdes (1) que é acessivel no canto
inferior esquerdo e umiaskbar no fundo do ecra, que permite comutar entre os
Varios programas a ser executados (2) e correr as aplicagdes mais importantes (3).

Tal como no KDE, por omisséo, séo disponibilizados quatro ambientes de tra-
balho, podendo este nimero ser alterado editando o ficheiro «preferences». A co-
mutacdo entre os varios ambientes de trabalho € facil e rapida devido a existéncia
de botbes n#askbar(4) .

Os vérios botbes do rato dao-nos acesso a diferentes menus. Pressionando o
botdo esquerdo temos acesso a um menu com as varias aplicacdes a correr nesse
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momento (5). O botédo direito, por sua vez, apresenta diferentes opcdes conforme
o local da éarea de trabalho: misktopmostra-nos o menu de aplicacdes (6), e
em aplicacdes minimizadas mostra-nos um menu com varias ac¢des que se podem
executar na janela da aplicagdo (mover, alterar tamanho, maximizar, minimizar,
etc).

Através dos menus Close -> Exit Window Manager, acessiveis no menu de apli-
cacoes (1), podera sair deste gestor voltando assim para o gektginde

Configuracéo

A configuragdo é totalmente feita através da edicédo de ficheiros dé. tdgtes
devem-se localizar na conta pessoal dentro do subdirectério «.icewm/». Dentro
deste deverao existir os ficheiros:

e preferences - opcdes gerais copaihs cores, fontes, nUmero de ambientes
de trabalho.

e menu - configuracdo do menu de aplicaces.

e programs - contém um menu gerado automaticamente com as aplistagdes
dard.

e winoptions - configuragdo de aplicagfes: icone, a existéncia de caixilho ou
barra de titulo, etc.

A edicao de ficheiros de texto serd abordada mais a frente neste capitulo.
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2.2.3 Window Maker

[m] xterm
| [root@localhost Aroot1#]

~ The GIMP

Figura 2.4: Ambiente de trabalho no Window Maker.

Descricao

Este gestor de janelas é totalmente diferente e inovador para quem nunca tenha tra-
balhado no sistema operativo NextStep, o qual tenta emular. O extinto NextStep

€ reconhecido como um dos melhores sistemas operativos que tém existido para o
desenvolvimento de aplicacfes estaveis e com excelente qualidade grafica; os prin-
cipios do seu funcionamento estdo bem definidos numa especificagéo aberta e livre,
chamada OpenStep, a qual esta a ser usada na nova geracdo de computadores Ma-
cintosh e no projecto GNUStep. O Window Maker foi desenhado em conformidade
com a especificacdo OpenStep, e o resultado € um gestor de janelas rapido e leve
para o sistema, mas ao mesmo tempo poderoso e agradavel graficamente.

Interface

Neste gestor, ao contrario do KDE, o menu de langamento de aplicagdes (1) é aces-
sivel em qualquer altura bastando para isso pressionar o botéo direito do rato em
gualquer ponto da area de trabalho. Para tornar a execucédo das aplicacfes princi-
pais mais facil existe ainda uma barra denomiriadek (2) onde se podem «colar»
icones (que quando pressionados executam as respectivas aplicacdes) ou aplica-
cOes especificas que ficam acopladas a esta barra durante a sua execucao (reldgios,
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gréficos da utilizacdo do processador, etc). Por cada aplicacdo que estiver a ser
executada, aparece um icone (os dois icones no canto inferior esquerdo, no caso da
Figura 2.4); estes icones podem ser deslocados até o Dock onde ficardo colados.

Pressionando o bot&o direito do rato sobre um dos icones derboattpentra-
se num menu que permite a sua configuracdo: opc¢des, propriedades da janela, lan-
camento automatico ao arrancar, etc. O botédo central quando pressionado da acesso
a um menu (3) com as aplicacdes a correr nesse momento nos varios ambientes de
trabalho.

Ao contrario de outros gestores de janelas o Window Maker apresenta, por omis-
séo, apenas uma area de trabalho podendo o utilizador acrescentar outras a medida
gue vai precisando. Para tal é apenas necessario criar uma nova atraveés do respec-
tivo menu (Workspace -> Workspaces -> New). Apos ter varias areas de trabalho
definidas a comutacéao faz-se atravéslifm(4) (normalmente no canto superior es-
guerdo) ou das teclas de atalho definidas na configuracéo (normalmente Alt-n, onde
n é o nimero da area virtual). O clip pode ser usado também para colar aplicacdes
gue depois podem ser executadas; 0 seu uso € um pouco mas flexivel do que o dock,
pois pode ser deslocado para qualquer zona e os icones que tiver colados podem ser
escondidos por meio de um toque duplo com o botéo esquerdo do rato.

Os menus Window Managers -> Exit, acessiveis no menu de aplicagbes (1),
permitem sair do gestor, tornando acessivel o gesttogie

Configuracéo

O Window Maker tem muitas opc¢des de configuragdo que podem ser acedidas fa-
cilmente por meio do rato, como ja falamos na seccéo anterior.

Existem também dois programas que ajudam na configuracéo geral do Window
Maker: os programa®/Prefs e wmakerconf (Figuras2.5e 2.6). Estes dois progra-
mas sao bons exemplos da grande qualidade, tanto do ponto de vista grafico como
do ponto de vista de funcionamento, do padréo de programacgéo OpenStep (que na
sua verséo livre esta a ser implementado por GNUStep).

O programa WPrefs permite configurar o comportamento do Window Maker em
geral, em quanto que o wmakerconf esta mais orientado a configuracédo do aspecto
gréfico (gréaficos de fundo aparéncia dos botdes e barras, etc). O programa wmaker-
conf também permite instaléemasque redefinem totalmente o aspecto visual. da
area de trabalho.
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2.2.4 Fvwm
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Figura 2.7: Ambiente de trabalho no Fvwm.

Descricao

O fvwm é, entre o0s gestores de janelas aqui apresentados, o mais antigo; foi criado
numa época em que o Linux era executado em maquinas muito mais lentas e com
menos memoria do que as actuais. Assim, o seu interface é muito simplista e a sua
configuracdo é mais dificil, jA que foi concebido para o trabalho rapido com uma
carga reduzida para o sistema.

Interface

O interface deste gestor foi pensado para ser modular, ou seja, € construido de
pequenos programas muito especificos. Todo o conjunto destes programas forma o
interface final. Assim este torna-se totalmente configuravel podendo adaptar-se as
necessidades e ao gosto do utilizador.

Este gestor apresenta wasktopque € utilizado para as janelas das aplicacdes
(1) e para os icones dos programas que estdo a correr minimizados (2). No fundo
deste existe ainda um maédulo (3) (denominado «Goodstuff») que permite correr as
principais aplicacdes através de botdes que Ihe estao acoplados.
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Premindo o botdo esquerdo do rato temos acesso ao menu de aplicacdes (4)
enquanto o botdo direito mostra um menu com 0s programas que estao a ser exe-
cutados nesse momento (5). O botdo central da acesso a um menu (6) com varias
accoes que se podem aplicar a uma janela: mover, redimensionar, minimizar, etc.

O numero de ambientes virtuais € definido no ficheiro de configuracdo e a co-
mutacéo entre eles é feita através de um modulo denominado «Pager» (7) que nor-
malmente esta acoplado ao médulo «Goodstuff».

Para sair deste gestor basta executar o comando Exit fvwm -> Yes, Exit fvwm,
acessivel no menu de aplicagfes (4), tornando-se assim acessivel o gksgor. de

Configuracgéo

A sua configuracao é totalmente feita através de um ficheiro dé {etwmrc) que
permite alterar todo e qualquer aspecto do gestor de janelas: o fundo, as aplicagdes
e modulos a correr no inicio de cada sessao, a existéncia de caixilho ou barra de
titulo, a fonte utilizada, o nUmero de ambientes virtuais, etc.

2A edicao de ficheiros de texto serd abordada mais a frente neste capitulo.
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2.3 Edicao e Visualizacao de ficheiros

2.3.1 HTML

O HTML (HyperText Markup Language) € o formato mais utilizado no mundo para

a publicacdo de paginas na Internet. E um formato livre baseado no SStsih- (

dard Generalized Markup Languagee pode ser criado por um grande nimero de
ferramentas diferentes, desde simples editores de texto até editores WYSIWYG
mais avancados. Utiliza um sistema de comandos (designadagsite html) que

faz a formatacao das frases e caracteres, atribui links, etc. Em Linux sdo inUmeras
as aplicagfes disponiveis para visualizar ficheiros deste tipo, sendo apresentadas
algumas a sequir.

Netscape Communicator

| Metscape: The Linux HOWTO Index: Index pa|
File Edit Wiew Go Window Help
4 = 3 X = <+ &
Back Forgard  Reload Home Search Metscape Print Security SO

| ¢ Bookmarks J Location: [[rile fusr /doc /MOVTO /other -fornats /htnl /m0vTo-10D. /| @57 What's Related

i 2 Webhail ¢ Contact 42 People ¢ Yellow Pages o Download 2 Find Sites [ Channels

3.1 HOWTOs j

The following Linux HOWTOs are currently available:

® 3Dfx HOWTOS, by Bermd Kreimeier <bki@gamers. org> How to use 30fx graphics accelerator chip support. Updated 6
Febmary 1998,

o AN HOWTD, by Terry Davson <terry@perf no.itg telecom. com.an> How to configuee AX25 networking for Linnz
Updated 17 Gotober 1997,

o Access HOWTO by Michael De La Rue <access-howto@ed.ac.uk> How to use adaptive technology with Linuzx.
Updated 28 March 1997,

® Alpha HOWTS, by David Mosherger < davidm@azstamet.coms Overview of Alpha systems and processors. Updated
& Tune 1997

® Aszembly HOWTO, by Frangois-René Ridean <Adean@ens fr> Informaton on programming in 36 assembly. Updared
16 Movernber 1997

® Bash Prompt HOWTO, by Giles O <giles @interlog coms Creating and controlling terminal and xterm prompts.
Updated 07 January 1999

® Benchmarking HOWTS, by André D. Balsa <andrewbalsai@usanet> How to do basic benchmarking, Updated 15
Angnst 1997,

® Beownlf HOWTS, by Jacek Radajewski <jacek@usq.edn.an> Donglas Eadline plogic.com> Introduces the Beowulf
Bupercomputer architecture and provides background information on parallel programoming. . Updated 22 Movember 1998,

® BootPrompt HOWTS, by Panl Gortmaker <gpgl09@rsphorl s edu.an=. List of boot time argumments and overview of
booting software. Updated 1 Febrary 1998,

® Bootdisk HOWTS, by Tom Fawcett <fawcett@croftjnet= How to create a bootroot maintenance disk for Linu.
Updated 1 February 1998

® Busmouse HOWTS, by Chris Bagwell <cbagwell @sprymet. come. Information on bus mouse compatibility with Linux, #

[= | 100% |

Figura 2.8: Netscape Communicator.

Este é o browser mais utilizado devido a estar presente na maioria das distri-
buicdes e de ser o mais completo disponivel em Linux. Tem um ambiente gréafico
bastante intuitivo e profissional e € compativel com as ultimas versdes de HTML e
Java.

3Uma «meta-linguagem» utilizada em projectos de documentac&o a grande escala.
4What You See Is What You Get
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Para abrir uma pagina eNetscape , basta executar os seguintes passos:

1. Abrir o Netscape através dos menus do gestor de janelas Personal -> Netscape
Communicator.

2. Abrir o menu File -> Open Page.

3. Escrever o endereco (internet ou local) da pagina HTML na caixa de dialogo.

Lynx

0| xterm X

Faculdade de Engenharia

de Engenharia
zidade do Porto

Thiz page iz optimized for :
[counter,gif]

[zince.gif]

andz: Use arrow keys to move, “?° for bhelp. ©
|_| ..E|r'||:| i ‘!:.l'l F

Figura 2.9: Lynx.

O Lynx €& um browser extremamente modesto mas ao mesmo tempo eficiente.
Trabalha apenas em modo de texto, o que o impede de ler imagens, JavaScript, etc.
Em vez disso, apresenta uma referéncia para os elementos que ndo consegue ler.
Devido ao facto de trabalhar em modo de texto, é extremamente rapido e valioso em
situacdes de sobrecarga do processador ou da rede. No fundo do ecré temos acesso
auma lista das varias op¢@es disponiveis, bastando pressionar a tecla destacada para
executar uma dada accao.

Para abrir uma pégina ebynx , seguir os seguintes passos:

1. Abrir o Lynx através dos menus Personal -> Lynx.

2. Pressionar «g» e escrever o endereco da pagina desejada.



24 Ambiente gréfico
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Figura 2.10: GV.

2.3.2 PostScript

O PostScript € uma linguagem de programacao, criada em 1985 pela Adobe, e op-
timizada para imprimir graficos e texto, ou seja, € uma linguagem de descri¢ao
de péagina. O seu principal objectivo é fornecer uma linguagem conveniente para
descrever imagens de um modo independente da maquina utilizada, ou seja, ndo
recorrendo a caracteristicas especificas de uma dada arquitectura. Na linguagem
PostScript, as imagens séo construidas em forma vectorial, definindo geometrica-
mente cada curva, em contraste com os gratiiosapnos quais a figura € obtida

pela definicdo de cadaixel num quadriculado da area total. No entanto, um fi-
cheiro PostScript pode também incluir uma imad@tmap perdendo assim a sua
propriedade de ser independente da resolugéo.

Para visualizar o resultado de um ficheiro em PostScript, € normalmente utiliza-
do o programayv . Esta aplicacéo, derivada do GhostView, tem um interface muito
simples, e apresenta apenas o essencial.

Para abrir um ficheiro PostScript congw, executar 0s seguintes passos:

1. Abrir o gv através dos menus Personal -> GV.

2. Abrir o ficheiro através do botdo Open, ou através do menu File -> Open, e
seleccionar o ficheiro a ser visualizado.
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2.3.3 PDF

O PDF (Portable Document Format) € um formato criado pela Adobe baseado no
PostScript. Foi estruturado para ser independente da plataforma, facilmente im-
presso, visualizavel e navegavel. A sua visualizacédo é fiel ao documento impresso
tornando-se quase uma fotografia do original. E um formato bastante divulgado na
Internet por ser um formato livre, o que faz com que existam inimeras plataformas
gue o suportam, e por existirgolug-inspara os principais browsers que permitem

a visualizacao de ficheiros PDF.

O PDF é uma boa opc¢éo quando as limitagcbes do HTML impedem a criagcéao de
um determinado documento. Por exemplo, as equacfes matematicas ndo podem ser
escritas em HTML; uma solucgédo seria criar um gréfico para cada equacéo, mas isso
torna a pagina bastante lenta de carregar e produz um resultado de baixa qdalidade.

As aplicacdes mais utilizadas para ver PDFs em Linux &dabe Acrobat
Reader e oXpdf .

Adobe Acrobat Reader

] guiapdf X

I —
|= &m0 K 5| [« ¢ |

Capitulo 1

Introducao

1.1 Introduc¢io ao curso

Bem vindo ao curso de «Introdugio a Redes e Linuxs da FEUP. Este curso tem
como objective a introdugiio a0s normais recursos que esta faculdade proporciona,
nomeadamente a FeupNET e o acesso exterior 4 Internet, bem como a ambiental-
izagio aos diversos sistemas operativos e utilitirios, como ferramenta primordial
para o sucesso escalar.

8.27 x11.63

Figura 2.11: Adobe Acrobat Reader.

O Adobe Acrobat Reader € o mais completo programa para ver PDFs,

SApesar de o HTML 4 ter suporte para equagdes matematicas, muitbsodesersmais conhe-
cidos e actuais ainda nédo aceitam estes comandos.
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ja que este formato foi criado pela Adobe. O interface é intuitivo e permite uma
navegacao simples e rapida dentro do documento a ser visualizado.
Para abrir um ficheiro PDF nscrobat Reader seguir 0s seguintes passos:

1. Correr o programa através dos menus do gestor de janelas Personal -> Acro-
bat Reader.

2. Abrir o documento através do menu File -> Open.

[ xpdF: guia.pdf

=l

Capitulo 1

Introducao

1.1 Introducio ao curso

Bem windo ao curso de «Introducfio a Redes e Linux» da FEUP. Este curso tem
como objecive aintrodugfio aos normais recursos que esta faculd ade proporciona,
nomeadamente a FeupNET e o acesso exterior & Internet, ber como a ambiental-
izacio aos diversos sistemas operativos e utilitirios, como ferramenta primordial
para o SUCEsso escolar.

Um dos nossos focos de interesse serd a rede interna desta cass, a qual, intrin-
secanas suas ramificacfes, einteressante naquilo quenos coloca ao dispor, ird ser
shordada usando wm sisterna operative que todos os dias ganhanovos adeptos o
Limuz, 7

Hé'i'ﬂil page |1 of 4 & e

| =

Figura 2.12: Xpdf.

O Xpdf é um visualizador de PDF mais modesto. Apresenta apenas 0 neces-
sario (mudar de paginapom imprimir) através de um interface grafico simples e
intuitivo. Os menus sao acedidos premindo o bot&o direito do rato muito ao estilo
de gestores de janelas tipo Window Maker e AfterStep.

Para abrir um ficheiro PDF n¢pdf , executar os seguintes passos:

1. Correr o programa através do menu Personal -> Xpdf.

2. Abrir o documento utilizando o comando Open, que pode ser acedido pre-
mindo o botéo direito do rato na janela do Xpdf.
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2.3.4 DVI
Xdvi: file:guia
Quit
Abort
Again
Reread
100%
-
Capitulo 1
33%
Introduca >
9 17%
1.1 Introducio ao curso First
Bem vindo ao curso de «Introdugiio a Redes e Linux» da FEUP Este curso tem Page-10
como objectivo a introdu¢io aos normais recursos que esta faculdade proporciona,
nomeadamente a FeupNET e o acesso exterior i Internet, bem como a ambiental- Page-5
izagdo aos diversos sistemas operativos e utilitirios, como ferramenta primordial
para o sucesso escolar. Prev
Um dos nossos focos de interesse serd a rede interna desta casa, a qual, intrin-
seca nas suas ramificagdes, e interessante naquilo que nos coloca ao dispor, ird ser Hext
abordada usando um sistema operativo que todos os dias ganha novos adeptos: o
Linux Page+5
— —

Figura 2.13: Xdvi.

O DVI (DeVice Independent) é um formato que normalmente resulta da com-
pilacdo de ficheiros na linguagem de descricdo de pagina TeX ou LaTeX, e que,
apesar do DVI ser bastante portavel, € normalmente convertido para PostScript ou
PDF.

A aplicacdo mais utilizada para visualizar um ficheiro DVI e que se encontra na
grande maioria das distribuicdes &avi

Para visualizar um ficheiro DVI utilizandoxalvi

1. Executar a aplicacao através dos menus do gestor de janelas Personal -> Xduvi.

2. Seleccionar o ficheiro desejado na caixa de dialogo.

2.3.5 Ficheiros de texto

Os ficheiros com nome a terminar etxt  costumam ser ficheiros de texto ASCII
nao formatado, ou seja, um formato completamente universal e independente da
maquina, e que é utilizado para diversos fins como documentacdo ou configuracéo
de programas.

Ha véarios métodos e aplicacdes para visualizar ficheiros de texto mas apresen-
taremos aqui uma aplicacdo que aproveita 0 ambiente grafico em que esta inserida:



28 Ambiente gréfico
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Figura 2.14: gEdit.

o gEdit . Este programa apresenta um interface simples e agradavel, e permite
a visualizacao de varios ficheiros através de um préactico sistema de separadores.
Apresenta ainda a possibilidade de busca dentro do ficheiro a ser visualizado e de
este ser alterado, tornando-se uma ferramenta practica e indicada para pequenas
alteracdes em ficheiros deste tipo.

Para visualizar ou editar um ficheiro de texto coEamlit

1. Executar a aplicacao através do menu Personal -> gEdit.
2. Abrir o menu File -> Open.

3. Selecionar o ficheiro desejado na caixa de dialogo.

2.3.6 Texto formatado

Tal como em outros sistemas operativos também o Linux tem a sua disposicao ferra-
mentas de edicdo de documentos. Um dos mais divulgados em LinBtaé®r-

fice . Este ndo é apenas um programa de edicdo de texto mas sim um conjunto de
ferramentas de escritério totalmente integradas numa sé aplicacdo e que permitem
editar quase todo o tipo de documentos: folha de calculo, base de dados, imagem,
HTML, diagramas, férmulas, apresentacdes, correio electronico, etc. Este progra-
ma pretende ndo ser apenas mais uma ferramenta mas sim uma area de trabalho
completa. Como tal apresenta wasktoponde se podem colocar atalhos para os
documentos mais utilizados e um menu acessivel no canto inferior esquerdo, muito
ao estilo do Windows, onde se podem correr 0s varios programas ou abrir docu-
mentos pessoais.



2.3 Edicao e Visualizacao de ficheiros 29
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Figura 2.15: StarOffice.

O StarOffice tem total compatibilidade com os pacotes de ferramentas de escri-
torio mais usuais tais como o Microsoft Office e Lotus SmartSuite, podendo haver
assim uma maior flexibilidade e interaccdo entre utilizadores de ferramentas e sis-
temas operativos diferentes.

Para comecar a trabalhar 8tarOffice

1. Correr oStarOffice através do menu do gestor de janelas Personal ->
StarOffice.

2. Carregar no icone que corresponde ao tipo de documento que quer criar ou

3. Correr o0 programa correspondente ao tipo de documento que quer criar atra-
vés do menu no canto inferior esquerdo.

2.3.7 Imagens

O Linux suporta todos os tipos de imagens mais usuais. Existem inimeros progra-
mas disponiveis para a visualizacdo de imagens, mas os mais divulgados e exis-
tentes em inUmeras distribuicdes s@dmvwe olmage Magick . Estes além de
permitirem a visualizacdo permitem ainda converter entre varios formatos, tirar
screenshotsaplicar filtros, imprimir, etc.

A edicado de imagens normalmente é feita co@imp, um programa de trata-
mento digital de imagem que permite atingir niveis quase profissionais muito pro-
ximos daqueles atingidos com o Adobe Photoshop ou o PhotoPaint da Corel.
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Figura 2.16: XV.

XV

O xv € um programa que permite a ver imagens de uma forma simples e rapida.
Suporta todos os formatos mais usuais e permite além da ver a imagem, imprimir,
aplicar efeitos como blur e sharpen, tisareenshotsetc.

Para visualizar uma imagem em:

1. Correr o programa através do menu Personal -> XV.

2. Pressionar o botéo direito do rato e seleccidad na caixa de dialogo.

Image Magick

OlImage Magick ¢é mais do que um visualizador. E um conjunto de aplicacdes
de consola que permitem a manipulacdo de imagens. Com este pacote pode-se
visualizar, converter, capturar, fundir, aplicar efeitos, dh@ambnailse imprimir.

Para visualizar uma imagem controage Magick :

1. Correr o visualizador de imagens do Image Magick através dos menus do
gestor de janelas Personal -> Image Magick.

2. Seleccionar o ficheiro na caixa de dialogo.

Gimp

O Gimp é o melhor programa de edi¢do de imagem disponivel para Linux. Tem
todas as potencialidades de um programa de tratamento de imagem profissional su-
portandolayers filtros varios,plug-ins e scriptsem scheme que se podem aplicar
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as imagens utilizando fung@es internas@imp. Estas funcdes estdo organizadas
numa base de dados (DB Browser) que apresenta uma pequena descricdo de cada
funcdo, os respectivos argumentos de entrada e o seu tipo. O Gimp apresenta ain-
da inmeras ferramentas de desenho, selec¢éo e retoque de imagem. Suporta os
formatos mais usuais, assim como o seu proprio formato (.xcf), e os formatos de
compressagzip ebzip2 parareduzir o tamanho das imagens ao mesmo tempo
gue grava ou |é.

Um exemplo da utilizacdo dGimp s&o osscreenshotslesta sebenta. Foram
totalmente produzidos com este programa, tanto na captura dos ecras como na alte-
ragdo dos mesmos.

Para produzir as imagens finais dos gestores de janelas utilizarkayesg
para separar 0s varios elementos da imagem: imagem de fundo, os elementos do
interface do gestor de janelas, os baldes, e 0s niUmeros. Isto permitiu que a alteracdo
de cada um destes elementos fosse facil e rapida, pois estaridgezsseparadas,
guando dois elementos se sobrepdem, a informagéo do elemento que fica em baixo
nao se perde. Assim, quando era necessario mover um menu ou a janela de uma
aplicacdo, a imagem de fundo que estava por baixo permanecia intacta. Uma outra
facilidade que alyerse oGimp permitem é a selec¢ao rapida dos varios elementos
através do comando Select -> Float. Este comando transforma uma selec¢do num
elemento flutuante que se pode mover dentro da imagem. O truque esta no facto
de caddayer ser transparente nas zonas em que néo tem informacéo de elementos,
setas ou numeros. Ou seja, se desejarmos seleccionar o numero cinco, por exemplo,
podemos fazer uma selecc¢do totalmente arbitraria a volta do nimero (e que ndo
englobe outros nimeros) e aplicar o comando Select -> Float. Como dentro da
nossa seleccdo sé ha o nimero cinco e transparéncia, ou seja, 0 nUmero e auséncia
de informacéo, este comando pode saber a forma exacta do numero e transforma-lo
num elemento flutuante. Tudo sem um grande esfor¢co da nossa parte para obter
uma seleccéao perfeita.

O Gimp tem muitas mais ferramentas e op¢des que permitem a facil manipu-
lacéo e seleccao de imagens, mas o aprofundamento destas técnicas esta fora do
ambito do nosso curso. Se estiver interessado em manipulacao e tratamento digital
de imagem com &imp, pode obter muita informacéo na Internet e ler o manual
completo totalmente gratuito.

Para editar uma imagem con@mp:

1. Correr oGimp através do menu Personal -> Gimp.
2. Criar uma nova imagem através do menu File -> New ou

3. Abrir uma imagem através do menu File -> Open.
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Figura 2.19: As variakyersque formam screenshotio Window Maker.
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Capitulo 3

Comandos Unix

Quando o Unix foi desenvolvido na década de 1970, a maior parte dos terminais
usados eram terminais de modo texto que ndo permitiam trabalhar no modo grafico.
A execucédo de programas era feita através da interaccdo corshetiaque € a
interface usada para interpretar comandos introduzidos através do teclado, executar
funcdes dentro dkerneldo sistema operativo e enviar resultados para o terminal.

A shellcontinua a ser de grande utilidade nos terminais graficos. O modo grafico
simplifica a interaccdo com uma aplicacdo por meio de menus que evitam que 0
utilizador tenha que lembrar nomes de comandos; mas em contrapartida o utilizador
fica limitado a usar o reduzido nimero de comandos que apare¢cam nos menus, e
nao os pode combinar nas diversas formas que sdo possiveis para quem trabalha
numa shell de Unix. Uma shell do Unix permite também a cria¢&cdpts, que
podem ser desde simples ficheiros com sequéncias de comandos predefinidos, até
complicados programas com execucao condicionada de diversos comandos.

3.1 Consolas ou terminais

Uma shell precisa da existéncia de uma «consola» de modo texto que serve de
interface entre o utilizador eshell Normalmente em Linux existem ja 6 consolas
virtuais predefinidas (designadosttiel atétty6 ) que podem ser acedidas com
as teclas Alt-F1, até Alt-F6. Quando se esta a trabalhar em X (no terminal virtual
namero 7), € preciso carregar simultaneamente as teclas Ctrl+Alt+Fn, onde n é
0 numero da consola virtual; para regressar ao X, usa-se Alt-F7. Cada consola
virtual apresenta uma mensagemlagn , que permite entrar no sistema e abrir
uma shell (a shell usada costuma kash , mas existem varias versées da shell).
Varias shells podem executar em simultaneo, independentemente, e até pertencendo
a diferentes utilizadores.

Uma outra forma de abrir uma shell quando se esta a trabalhar em X, consiste
em usar opg¢des de menu que abre uma consola com uma sessdo duma shell com
o0 mesmo nome do utilizador de quem esta a executar o programa X. Dentro dos
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menus do gestor de janelas aparecem algumas consolas como por exemplo o Xterm,

0 Rxvt e 0 Eterm.

3.2 Alguns comandos basicos

A primeira coisa que devemos explicar € como é que o sistema de ficheiros esta es-
truturado. O sistema de ficheirdddsystemé basicamente um sistema organizado
e hierarquico no qual sdo guardados dados sobre a forma de directérios e ficheiros.
Existem varios tipos, mas o que iremos estudar € o ExtEktided 2 Filesystem
usado com maior frequéncia nos sistemas Linux.
Uma analogia muito elucidativa é a de que um directério pode ser comparado
a uma gaveta. Dentro destas podem existir ficheiros ou ate mesmo outras gavetas,
as quais por sua vez possuem as mesmas propriedades. Cada um destes objectos
tem um nome associado, normalmente indicativo da sua funcdo. Estes directorios e
ficheiros estdo todos como que 'guardados’ numa grande gaveta, a qual chamamos
de directério raiz. Esta forma de organizacao forma o conceito de hierarquia.
Usa-se uma barra diagorigdara separar os nomes de directorios e subdirecto-
rios. A distribuicdo e nomes dos directorios segue alguns padrdes gerais com algu-
mas variacoes. Um sistema tipico de ficheiros de Linux pode apresentar a seguinte

organizacao:

MAPA
/
|- boot
|- vmlinuz
|- System.map
|- dev
|- hdal
|- fdO
|- ttySO
|- etc
|- conf.modules
|- init.d
- Ipd
|- home
|- €i92001

Representacdo Textual
/
/boot
/boot/vmlinuz
/boot/System.map
/dev
/dev/hdal
/dev/fd0
/dev/ttySO
letc
/etc/conf.modules
/etc/init.d
/etc/init.d/Ipd
/home
/home/ei92001

O directorio / € o directorio raiz. O directorietc € onde sdo armazenados 0s
ficheiros de configuracéo do sistema e unicamente o superusuario pode altera-los.
O directério/dev é especial no sentido de que os seus ficheiros sédo realmente dispo-
sitivos do sistema; assim, por exemplo, se enviarmos dados para o fichefid)



3.2 Alguns comandos bésicos 37

estaremos realmente enviando dados para o disco flexivel. No diredioitie
aparecem os subdirectorios dos utilizadores, onde estes tém permissao para criar e
alterar ficheiros. Uma forma abreviada de represehtaie/ci92001 (directério de
trabalho do utilizadoei92001) € ~ei92001.

Alguns comandos dahell que nos permitem navegar por entre o sistema de
ficheiros sdo os que se seguem:

Is Permite obter uma listagem dos ficheiros e subdirectérios existentes num direc-
torio. Por exemplols /etc mostrara todos os ficheiros e subdirectérios do
directorio/etc. Sem nenhum arguments, mostra o contetdo do directorio
corrente. O comandls ja pode ter sido configurado com algumas opc¢des
como, por exemplo, a op¢ao de representar subdirectérios e diversos tipos de
ficheiro em diferentes cores. Uma outra op¢do muito util é a ofcatas
opcdes de um comando geralmente sdo precedidas por um hifen) que indica
que sera usado um formato mais comprido com mais informacg&o; assim por
exemplo, o comando

Is -l

pode produzir uma listagem como a seguinte

total 123

-rw-r--r-- 1 root root 126 Jul 16 1998 XDvi
drwxr-xr-x 2 root root 5120 Sep 19 17:31 dvips
-rw-r--r-- 1 root root 2165 Jun 3 14:52 fmtutil.cnf
-rw-r--r-- 1 root root 2391 Jun 28 18:39 language.dat
-rw-r--r-- 1 root root 635 Feb 9 1999 mktex.cnf
-rw-r--r-- 1 root root 89910 Nov 2 1998 modes.mf
drwxr-xr-x 2 root root 1024 Sep 19 17:41 pdftex
-rw-r--r-- 1 root root 18895 Sep 19 17:42 texmf.cnf

agora € possivel distinguir entre ficheiros e subdirectérios: nos subdirectérios
aparece um d na primeira coluna; neste caso existem dois subdiredidpos

e pdftex. As letras a seguir a primeira coluna indicam as permissdes dos fi-
cheiros e subdirectérios, como veremos mais para a frente. A seguir as letras
vem um numero que indica quantos outros ficheiros tém sido «enlagados» ao
ficheiro ou subdirectorio (niumero de enlaces simbdlicos ou ficheiros dentro
de um subdirectério). As duas colunas onde aparece a patetraindicam

o0 nome do dono do ficheiro e o grupo ao qual pertence (neste caso o superu-
suario ouoot ). A seguir vem um nimero que indica o tamanho em bytes; e

o total de kilobytes do directoério, 123, aparece na primeira linha. Finalmen-
te temos a data de criacdo ou Gltima modificacdo, e o nome. E importante
salientar que nos nomes distingue-se entre maildsculas e minusculas.

Uma outra opcao util éA para mostrar também ficheiros e subdirectérios
ocultos (aqueles com nome a comegar por ponto).
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cd Para mudar o directério corrente, usa-se o comaadchange directory. Se
acabarmos de obter a listagem obtida acima torl |, imediatamente a
seguir poderiamos deslocar-nos para o directdrips por meio do comando

cd dvips
Para subir um directorio, até o «pai» do directorio corrente, usa-se:
cd

Ou podemos simplesmente deslocar-nos a um directorio qualquer indicando
0 seu nome completo:

cd /home/ei92001/trabalhos/Janeiro

pwd (Print Working directory) Chegard sempre um momento no qual ndo lem-
bramos o directorio corrente onde nos encontramos (embshelbpossa
estar configurada para mostrar o directorio corrente antgsatop). Nes-
ses casos, o comangavd € (til para mostrar o nome completo do directério
corrente.

mkdir (Make Directory) Este é o comando usado para criar um subdirectério do
directorio corrente. Por exemplo:

mkdir programas

cria um subdirectorio com nom@ogramas. Embora a sintaxe dos nomes

dos ficheiros e subdirectérios seja bastante flexivel, convém ndo exagerar,
para ndo terminar com nomes complicados ou com caracteres especiais que
possam confundir ghell

rmdir (Remove Directory Usado para apagar subdirectérios. Para que funcione,
sera necessario que o subdirectério a ser apagado esteja vazio. Se o sub-
directério ndo estiver vazio, podemos forcar a sua eliminacdo por meio do
comando:

rm -r subdirectério

Mas use este comando com discri¢ao ja que, como norma geral, ficheiro ou
directério que seja apagado sera perdido para sempre.

Para poder criar ou apagar subdirectorios sera preciso ter permissao para mo-
dificar o seu conteudo. Isto nos traz de volta a informacao que aparecia nas
primeiras colunas da listagem obtida césn-I . Como vimos, cada fi-
cheiro tem um criador, e um grupo de utilizagcdo. Estes sdo-nos indicados
pelas colunas 3 e 4 do exemplo acima. Cada ficheiro ou subdirectério pode
ter permissdes de leitura (r), modificacdo (w), incluindo a possibilidade de
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ser apagado, e de execucao (x), definidas independentemente para o dono do
ficheiro (u), o grupo de utilizacdo (g), e outras pessoas (0).

Por exemplo, o ficheiréanguage.dat que aparecia na listagem acima tinha a
seguinte informacéao:

-rw-r--r-- 1 root root 2391 Jun 28 18:39 language.dat

Os trés caracteres a seguir a primeira coluwa, correspondem as permis-
sbes do dono (neste caso root), que permitem leitura e modificacdo mas nao
execucdo. Os trés caracteres seguintes,, indicam as permissdes para o
grupo (um grupo também chamado root neste caso) que unicamente permi-
tem leitura. Finalmente, outros utilizadores tém as mesmas permissdes que
para o grupo de utilizacda-{ ). O superusuériorgot) normalmente € o
unico a quem € permitido ultrapassar as suas permissoes.

chmod, chown e chgrp Estes trés comandos sdo muito Uteis para modificar as pro-
priedades de um ficheiro ou subdirectério. O comando

chown nome.grupo ficheiro

modifica 0 «<nome» do dono do ficheiro e do «grupo» de utilizacdo de um
«ficheiro»; se ndo for dado um grupo, o grupo continua igual. Quem usa este
comando devera possuir autorizacéo para modificar o ficheiro, ou ser o dono
dele, e devera ter cuidado para nao terminar com um ficheiro que ele préprio
ja ndo possa alterar por néo lhe pertencer. O comahdp € semelhante

mas modifica apenas o grupo e, portanto, precisa apenas do nome do grupo e
do ficheiro.

O comandachmod usa-se para modificar as permissées de um ficheiro ou
directério da seguinte forma: primeiro dizemos a quem vamos modificar as
permissdes: ‘U’, ‘g’ ou ‘0’. A seguir, indicamos a propriedade que queremos
modificar: 'r’, 'w’, 'X’, a seguir usamos ou ‘=" para definir as permissdes
exactas, ou ‘-’ ou ‘+’para desactivar ou activar alguma permissao: ‘r’, ‘w’ ou
‘X’. Uma virgula separa multiplas op¢des. Por exemplo, se o dono de um
ficheiro notas.txt unicamente para leitura quiser modifica-lo, podera usar o
comando

chmod u+w notas.txt

Ou se quiser dar a capacidade de executar um ficheiro chamxaadm. me.sff
a qualquer utilizador,

chmod +x executa.me.sff
Um exemplo mais complexo seria

chmod u+rw-x,g+r-wx,0-rwx exames.de.ipcl
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In (Link.) Este comando cria utink, ou seja, faz apontar um ficheiro para outro,
como se tivéssemos dois nomes diferentes para nos referirmos a um ficheiro.
E conveniente usar unicamefitgks simbolicos, por meio da opgas . Um
link simbdlico representa um nome ficticio para um ficheiro real, em quanto
gue nodinks ndo simbdlicos os ficheiros estdo ligados fisicamente podendo
criar situacbes confusas quando de tiver que apagar o renomear um deles.
Por exemplo, suponha que no seu sistema existe um ficheiro com uma ima-
gem /usr/share/icons/wmaker-work.tif que quer usar para um trabalho que
esta a realizar no seu directorio de trabalho. Para néo ter que copiar o fichei-
ro, ficando duas copias idénticas no mesmo sistema, pode criar um enlace
simbdlico:

In -s /usr/share/icons/wmaker-work.tif work.tif

Cada vez que referir o ficheirwork.tif no seu directorio, estara realmente

a usar o ficheiro original. Se o administrador do sistema instala uma nova
versao melhorada do ficheiremaker-work.tif, 0 seu enlace apontara auto-
maticamente para a versao mais recente; e podera apagar o seu enlace sem
produzir alteragdes no ficheiro original. Os links simbdlicos aparecem indi-
cados na primeira coluna da listagem produziddgot , por meio de uma

letra ‘I".

cp (Copy) Faz uma copia integra de um ficheiro:
cp original copial

Copia integralmente o ficheirariginal para dentro de um novo designado
por copial. Também é possivel copiar vérios ficheiros

cp exemplo*.ps subdir

O caractef é substituido por qualquer sequéncia de caracteres que produza
um ficheiro que exista; neste caso em que se copiam de vario ficheiros, o
altimo argumento subdir, devera ser o nome de um directorio onde seréo
copiados os ficheiros; pode usar um ponto para indicar o directério corrente,
guando estiver a copiar ficheiros provenientes de outro directorio.

mv (Move.) Move um ficheiro ou directério para outro lugar:
mv /home/quim/aquitoufixe /home/toze/

move o ficheiraquitoufixe para dentro do directoricthome/toze/
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3.3 Processos

Quando um aplicativo € executado, o sistema atribui-lhe espaco em memoria,
e da-lhe um identificador. O mesmo aplicativo pode correr outros programas,
ou invocar outros aplicativos. A cada uma destas tarefas chamanpos-de
cessos Este processo pode ocupar grande parte do processador, ou pouca.
Pode ate mesmo ter prioridade sobre outros processos, ou ser algo nao mui-
to importante que corre quando o processador tem tempo. Sendo assim, um
processo possui inUmeras propriedades, dentro das quais podemos destacar
o PID (Process Identifigr o utilizador que fez a invocacdo do processo, o
comando executado e a prioridade. Um simples comando denominado por
top deixa-nos ver, de uma forma intuitiva, 0s processos que estao a correr;
umtop num sistema pode resultar em algo do tipo:

2:34am up 13:25, 3 users, load average: 0.21, 0.05, 0.02
44 processes: 42 sleeping, 2 running, 0 zombie, O stopped
CPU states: 5.3% user, 0.9% system, 0.0% nice, 94.0% idle
Mem:  63268K av, 59960K used, 3308K free, 19696K shrd, 2636K buff

Swap: 124988K av, 23620K used, 101368K free 29792K cached
PID USER PRI NI SIZE RSS SHARE STAT LIB %CPU %MEM  TIME COMMAND
181 root 17 O 30740 24M 6428 S 0 2.7 39.9 101:50 X
210 root 8 0 2360 1348 600 R 0 27 21 0:02 Eterm

1866 root 5 0 768 768 596 R 0 05 12 0:01 top
187 root 1 0 2768 1708 944 S 0 01 26 0:59 enlightenment

lroot 0 O 60 56 44 S 0 0.0 0.0 0:04 init
2root 0 O 0 0 0 SW 0 0.0 0.0 0:00 kflushd
3root 0 O 0 0 0 SW 0 0.0 0.0 0:00 kupdate
4root 0 O 0 0 0 SW 0 0.0 0.0 0:00 kpiod
5root 0 O 0 0 0 SW 0 00 0.0 0:00 kswapd
94 root 0O O 268 216 176 S 0 0.0 03 0:00 syslogd
98 root 0 O 420 164 140 S 0 0.0 0.2 0:00 klogd

Outro comando que faz basicamente 0 mesm@®:0

PID TTY STAT TIME COMMAND
151 1 SW 0:00 (bash)

152 2 SW  0:00 (mingetty)
153 3 SW  0:00 (mingetty)
154 4 SW  0:00 (mingetty)
171 1 SW 0:00 (startx)

172 1S 0:00 tee /root/.X.err
180 1 SW  0:00 (xinit)

183 1S 0:00 gnome-session
187 1S 0:59 (enlightenment)
210 1S 0:03 Eterm

1674 pl S 0:00 -bash

1682 pl S 0:04 pico COMANDOS.unix
1867 pO0 R 0:00 ps
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Imaginemos agora que, repentinamente, um processo deixou de responder,
por exemplo enquanto executavaeiscape . De forma a poder continuar

a usar o sistema operativo sem o ter de desligar, eu poderia tentar terminar o
processo com o comandtdl . Para isso, primeiro verificaria qual € o PID
com o comand@s (oups ax que e uma forma mais alargada, mostrando-
nos todos 0s processos que a maquina esta a correr):

1969 1S 0:50 netscape

(Para os mais curiosos, existe uma forma de mostrar apenas as linhas que nos
interessam n@s, que consiste em tirar partido das propriedadegipiag e

do comandgrep . Algo do géner@s ax | grep netscape ). Depois
enviaria um sinal ao programa para ele terminar:

kill netscape

E estaria tudo resolvido. Infelizmente o programa pode mesmo estar a ignorar
todo o tipo de sinais. Sendo assim, a Unica coisa a fazer seria enviar um
sinal directamente para o sistemak@rnelpara ser mais preciso) de modo a
terminar de imediato o processo. Algo do género:

kill -9 netscape

Resultaria perfeitamente

Por outro lado, poderiamos querer terminar todos 0s processos que se cha-
memnetscape fariamos o seguinte:

killall -9 netscape

3.4 Mais informacgoes

As opcoes disponiveis para um determinado comando, e uma sinopse do seu uso,
podem ser obtidos através de:

man nome-do-comando

o qual mostra @agina de manualdo comando ou programa.

Temos falado apenas de uns poucos comandos do muitos existerstesllina

Também nao temos aprofundado em outros conceitos importantes como o re-direc-
cionamento da saida, processamento condicionashyipts Para obter estudar

mais acerca dahell consulte por exemplo a pagina de manuabdsh . E con-
veniente também usar uma das interfaces de hipertexto para as paginas de manual,
por exemplo no URL:

19 é 0 numero que se da ao sinal SIGKILL.
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http://quark.fe.up.pt/cgi-bin/man2htmi

Assim conseguira obter uma lista por secc¢des e por ordem alfabética, de todos os
programas e comandos externashall existentes num sistema Linux tipico.


http://quark.fe.up.pt/cgi-bin/man2html

44

Comandos Unix




Capitulo 4

Sistema Distribuido

Um sistema distribuido (SD) € um conjunto de computadores interligados através
de uma rede de comunicacdes, desempenhando papéis de clientes (utilizadores de
servicos) ou servidores (fornecedores de servicos). Um utilizador pode entrar no
sistema distribuido a partir de algum dos computadores que formam a rede; a conta
e os ficheiros do utilizador serdo os mesmos independentemente da maquina que
estiver a usar. Este sistema € muito mais flexivel e apresenta grandes vantagens
ao utilizador, mas para aproveitar estas vantagens € preciso ter alguma ideia da
arquitectura da rede.

Neste capitulo estudaremos dois dos sistemas distribuidos existentes na Facul-
dade de Engenharia: A rede Linux do Departamento de Engenharia Electrotécnica
e de Computadores (DEEC) e a rede do Centro de Informética Prof. Correia de
Araujo (CICA). Embora estas paginas estejam orientadas as pessoas que usam es-
tas redes, alguma da informacéo dada é geral a qualquer sistema distribuido e pode
ser de utilidade a outros.

4.1 Arede Linuxdo DEEC

Actualmente o DEEC possui sete servidores Linux distribuidos por trés dominios:
edificio do autocarro (EA), edificio cor-de-rosa (CR) e edificio parque-auto (PA),
tal como é apresentado na figurd. Estes servidores do sistema distribuido (SD)
fornecem:

e espaco em disco aos utilizadores Linux do DEEC (alunos e professores), bem
como o espaco em disco de alguns utilizadores irredutiveis do Windows.

e espaco em disco para software de grande volume de qualquer um dos sistemas
operativos suportados pelo DEEC (Windows NT, 9x e UNIX),

e espaco em disco para documentacao sobre os mais diversos assuntos de inte-
resse da comunidade informética do DEEC,
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e correio electrénico para os utilizadores do Linux do DEEC e lista de mail do
Reino Linux (cortes@reinolinux.fe.up.pt),

e paginas HTML do Reino Linux (grupo de utilizadores Linux da FEUP
http://reinolinux.fe.up.pt do sistema distribuido do DEEC
(http://deecO0ws29.fe.up)pe do laboratério de redes
(http://netlab.fe.up.pt

CPU Server (rsh)

File Server (NFS) CPU Server (rsh) File Server (NFS)
Information Server (NIS) File Server (NFS) WERB Server (HTTP) WERB Server (HTTP)
N = N N~
l Servidores
\ \ Dominio do EA
deecO2ws12 deecO2wsl4 deecO2ws01 deec02ws16
Management Server (SNMP)
CPU Server (rsh)
=
Servidores
\ Dominio do PA
loule
(Solaris)
Printer Server (LP) MAIL Server (HTTP, POP)
File Server (NFS) WEB Server (HTTP)
Infor mation Server (NIS) CPU Server (rsh) CPU Server (rsh) .
Servidores
Dominiodo CR
deecOOWs29 deecOOWs25
deecO2ws02 deecO2ws03 deecO2ws04 deecO2ws05 —deec02ws06 C| | entes
deecO2ws07 deecO2ws08 deecO2ws09 deecO2wslO deecO2wsll
deecO2ws13 deecO2wsl7 deecO2wsl18 " 1 SaIaEA34
=4
douro
Clientes
SdaCR4
Clientes
SalaCR1

Figura 4.1: Dominios do SD do DEEC

4.1.1 Contas dos Utilizadores

No sistema distribuido do DEEC cada utilizador € identificado pologim , tem
umapassword , para (tentar) garantir que seja o Unico a usa-lo, e um espaco e
disco para poder guardar ficheiros. A este trio em geral chancarde, i.e., 0
utilizador pode entrar em qualquer maquina do SD com o seu login e password
acedendo sempre ao seu espaco em disco, ou area de trabalho. Para quem ainda
tem duvidas, o login, a password e a sua &rea de trabalho sdo Unicos em todas as
magquinas do SD


http://reinolinux.fe.up.pt
http://deec00ws29.fe.up.pt
http://netlab.fe.up.pt
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Esta uniformidade € conseguida devido a existéncia do servico de informacéo
NIS!. O computador servidor principal deste servico é conhecid®poridor
Mestre € onde toda a informacéo do sistema distribuido é introduzida, nomeada-
mente informacé&o sobre a conta do utilizador,.

Como o SD do DEEC se espalha por varios edificios e como tem um numero
elevado de estacdes clientes, foram instalados div8exvsdores Escravos
nos varios dominios do SD. Estes servidores escravos contém uma réplica exacta
da informacgao presente no servidor mestre. Quando um utilizador fdegim
numa maquina, esta pergunta ao servidor de NIS mais proximo se a password esta
correcta e, em caso afirmativo, pede também a localizacé&o fisica (servidor remoto,
sistema de ficheiros) da area de trabalho. De seguida monta a area de trabalho do
utilizador no directérichome da maquina em questéo para o utilizador a poder usar.
Concluséo, se um utilizador escrever um texto que guarda na seu espaco em disco
de uma estacgéao de trabalho, quando quiser continuar o texto ndo necessita de entrar
exactamente na mesma estacao de trabalho, pois o seu espagco em disco € unico e
aparecera em qualquer computador em que entre.

Como dissemos atras as areas de trabalho dos utilizadores aparecem montadas
em/home. Sempre que alguma operagdo envolva ficheiros da sua area de trabalho,
esta € montada automaticamente. Para se verificar tal facto podem proceder a uma
experiéncia utilizando o comando :

Is - /home

este comando vai vos indicar o0 que esta/tome. Podem ver as contas que estao
montadas neste computador e uma delas € a vossa. No meu caso a resjgosta do
foi:

pbraga@
de seguida listar a conta de um utilizador qualquer:
Is ~caloiroedu

o til imediatamente anterior ao nome do utilizador serve para indicar o espaco
em disco de um dado utilizador. BdNIX todos os utilizadores tém um espago em
disco que pode estar em qualquer ponto da hierarquia de ficheiros. Assim, utilizan-
do otil, poupamos trabalho de pesquisa e temos a certeza de que estamos a indicar
a posicéo certa — a conta do utilizador. Neste caso usei o utilizatimroedu
O importante para esta experiéncia € que a conta deste utilizador ndo esteja ainda
em/home.

Por ultimo, execute outra vez o comandode/home:

Is /home

0 meu resultado foi o seguinte:

INIS — Network Information System
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caloiroedu@ pbraga@

poderd ver que apareceu a conta do utilizaddoiroedu  em/home.
Para saber a localizagéo fisica da minha conta posso executar o colmando
-l /home . Como exemplo de resposta:

total 4

Irwxrwxrwx 1 root 29 Sep 10 11:59 ee99777 -> /amd/deec00
ws27/€99-1/ee99777/

Irwxrwxrwx 1 root 32 Sep 10 11:29 pbraga -> /amd/deec02w
s12/usr/pedro/pbraga/

olhando para estas duas linhas podem ver que o utilizae@®777 tem a sua
conta na maquindeecO0ws27 nafile-systene99-1 . i.e., 0 nome da maquina
vem sempre a seguir/amd e depois o que fica entre 0 nome da maquina e do
utilizador é afile-system

4.1.2 Sistema de Ficheiros Distribuidos

O servico principal do SD do DEEC ¢ de facto o sistema de ficheiros distribuidos,
gue proporciona o aparecimento da area de trabalho de cada utilizador em qualquer
maquina de uma forma quase transparente. Para além disso, este servi¢o é ainda
importante para outros sistema de ficheiros, como sejam aqueles contendo espagos
correio electronico, software e documentagéo.

Um sistema de ficheiros distribuidos pode ser dividido em duas partes princi-
pais: a montagem de sistemas de ficheiros remotos e 0 acesso aos ficheiros. No
caso do SD do DEEC usaram-se dois protocolos para esse efeito: Mount e NFS.

Mount

Por esta altura devem estar a perguntar a vos proprios:

Mas afinal o que vem a ser isto de montar? Tem a ver com cavalos ou
bicicletas?

Quando se coloca uma disquete nB@-DOS, passamos a ter acesso ao seu
sistema de ficheiros usando para isso a designag&a ©epois, se trocarmos de
disquete, passamos a ter um sistema de ficheiros diferente na mesma designacao
l6gica («A:»). Ora, o que se fez foi montar a primeira disquete émxpara de
seguida a desmontarmos e montarmos a segunda. Portanto:

Montar é associar umfile-systenfisica a um ponto da estrutura
|6gica de ficheiros do Sistema Operativo.
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NFS

Como ja referimos atras, montar urile-systeng associa-la a um ponto logico da
estrutura de ficheiros. Mas como é que se consegue associdilessstengue
se encontra fisicamente noutro computador a estrutura de ficheiros do computador
local?

Existe um servigo cujo nome é NF&ue, através da rede de comunicacgdes, for-
nece a um computador acesso a Uditeasystenremota de modo transparente para
0s restantes processos. Ao computador que disponibdifile-systenchama-se
deservidor de NFS edecliente de NFS aocomputador que utiliza esse
servico. A figurad.2 exemplifica a arquitectura deste servigo, mostrando servidores
exportando sistemas de ficheiros, e clientes montando-os constituindo arvores de
directorios baseadas em sistemas de ficheiros locais e remotos.

NFS Server A | Filesystem 1 NFS Server C ] Filesystem 1
Filesystem 2 /' Filesystem 2
A A
Filesystem 3 Filesystem 3
Filesystem 4 Filesystem 4

{ NFS Server B },,/ Filesystem 1

4 Filesystem 2
Filesystem 3
Filesystem 4
NFSClientp |/ AFileystem2 NFSCliene |/ C:Fileysemy
B:Filesystem 1
C:Filesystem 3
NFS Server A NFSClient D

Py Remote Filesystems A,2;B,1;C,3

Local Filesystems1 a4 Local Filesystem

. =

Figura 4.2: Sistema de ficheiros distribuidos baseado em NFS.

Assim numa estacdo de trabalho existem diversos sistemas de ficheiros, uns
locais outros remotos, para o verificar execute o comahdaum terminal X:

Filesystem 1024-blocks  Used  Avail. Capac. Mounted on
/dev/hdal 97556 63615 28903 69% /
/dev/hda3 1190046 513134 615424 45%  fusr

deec00ws29:/var/spool/mail

3842436 1269507 2374125 35% /var/spool/mail
/dev/hda4 1127638 686665 382711 64% /homel4d
deec02ws12:/homestaff

1018298 777271 188416 80% /amd/deec02ws12/homestaff

2NFS — Network File System
30 termo técnico usado neste casexgortara file-system
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deec02ws14:/homels 1127638 686665 382711 64% /amd/deecO2wsl14/homeld
deec00ws27:/homestaff2
3648613 1118884 2340983 32% /amd/deecO0ws27/homestaff2

Do resultado do comando apercebemo-mos que as trés particées do disco local:

e /dev/hdal,
e /dev/hda2,

e /dev/hda4,
foram montadas nos directérios

o/
e /usr

e /homel4
Por outro lado os quatro sistemas de ficheiros remotos:

e /var/spool/mail,
e /homestaff,
e /homel4,

e /homestatf2),

respectivamente dos servidores deecO0ws29, deec02ws12, deec02wsl14 e de-
ec00ws27, foram montados nos directorios:

e /var/spool/mail,

o /amd/deec02ws12/homestaff,
o /amd/deecO2ws14/homel4,

o /amd/deecO0Ows27/homestaft2.

Para além disso ainda nos é possivel ver o tamanho total dos sistema de ficheiros
em blocos de 1kB, bem como o espaco usado e disponivel.
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4.1.3 Servico de Impresséao Distribuida

O servico de impressao distribuida concebido no DEEC, e que se encontra em fase
de implementacédo, € composto por diversos elementos:

e impressoras,

servidores de impressao,

base de dados,

filtros

filas de espera.

Quando o utilizador pede para imprimir um ficheiro tem que especificar o nome
da impressora e o nome do ficheiro. Os trabalhos de impresséao sao todos enviados
para o servidor de impresséao que analisa o pedido e os faz passar por filtros para, por
exemplo, contar o nimero de paginas a imprimir, verificar na Base de Dados se a
impressao em curso ndo excede a cota do utilizador, ou garantir que o ficheiros esta
no formato correcto (PostScript). Na situacdo do trabalho de impresséo ser aceite
ele é enviado para uma fila de espera correspondente ao nome légico da impressora
usada . De facto, uma impressora fisica pode ter mais que uma impressora logica,
por exemplo, para imprimir em face simples ou dupla

Imprimir em Linux

No SD do DEEC para se imprimir um ficheiro a partir do sistema operativo Linux
deve-se utilizar o comando:

Ipr -P<impressora> <ficheiro>

em que <impressora> € o nome logico associado a uma impressora fisica onde
se quer imprimir e <ficheiro> € o nome do ficheiro a imprimir. Em principio esse
ficheiro tera que estar no formato PostScript(PS), e os nomes dos ficheiros tém,
normalmente«.ps» no fim.

As impressoras localizadas em salas de alunos estdo sujeitas a uma gestao de
cotas baseada no numero de impressdes por utilizador. Para verificar o estado das
impressoras e da sua cota o utilizador pode consultar uma pagina Web do SD do
DEEC dedicada a esse fim:

http://deecO0ws29.fe.up.pt/impressora/

4Como & o caso da impressora da sala EA3.4.
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4.1.4 Correio Electrénico

No SD do DEEC todas as maquinas Linux funcionam como servidores de mail, dai
gue é possivel enviar e receber mensagens a partir de qualguer uma destas maqui-
nas. Contudo, como a maioria das maquinasdeal boot néo é garantido que
maquina esteja permanentemente em Linux e como tal que o servidor de mail esteja
em funcionamento. Assim, as maquinas que de momento estdo permanentemen-
te ligadas em Linux e as quais todos os utilizadores tem acesso sédo: deecO0Ows25,
deecO0ws29, deecO2ws16 e deec02wsO01.

Nas maquinas Linux do SD do DEEC quando chega uma mensagem para um
utilizador, esta € guardada efvar/spool/mail/. Para garantir que o utilizador n&o
tem que andar a ler as mensagens a si dirigidas em todas as maquinas do SD do
DEEC, o directério/var/spool/mail de todas as maquinas é importada da maquina
deec00ws29, servidor de mail oficial do SD do DEEC. Se repetir o conginda
encontrar uma linha no resultado que |he diz quepool do correio electronico
provém de facto da maquina deeecOOws29.

Filesystem 1024-blocks Used  Avail. Capac. Mounted on
deecO0ws29:/var/spool/mail 3842436 1271694 2371938 35%  /var/spool/mail

/ mailServer

usr var
spool
mail
(NFS Server)
/ mailServer: / mailServer:
s Ivar/spool/mail . Ivar/spool/mail
spool spool
mail Client1 mail mailClient2 mail
(NFS Client) (NFS Client)

Figura 4.3: Utilizacédo conjunta do sub-sistema de correio electronico e sistema de
ficheiros distribuidos.

A figura 4.3 da uma ideia dos principios usados para colocar 0 mesmo espaco
em disco dedicado apool mail em todas as maquinas. Note-se que o sistema
de mail do SD do DEEC é suportado fortemente nos mecanismos de sistemas de
ficheiros distribuidos, neste caso particular no NFS.
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Leitores de Correio

Em Linux a forma mais simples de ler o correio electrénico recorre ao comando
elm, que Ihe proporciona uma interface de texto ligeira e de facil uso para ler
mensagens simples. O prograelia sempre que arranca vai ler nar/spool/mail
o ficheiro correspondente ao utilizador e permite ler o correio directamente sobre o
sistema de ficheiros usado pelo servi¢o de wvaiVspool/mail.

O comando UNIXfrom permite-lhe ver as mensagens que estdo na sua caixa
de correio sem ter que invocar umailer °

4.2 Servicos informaticos do CICA

O CICA (Centro de Informética Prof. Correia de Araujo) é o centro informatico da
Faculdade de Engenharia e tem como fungdes:

e Gerir arede e as maquinas que a compdem e ser responsavel pela manutencao
e reparagao da mesma.

e Tem a disposicao dos alunos duas salas de computadores que se localizam no
edificio central da faculdade.

e Administra a rede WIinNT.

e E responsavel por introduzir na rede os programas/aplicacdes exigidas para o
bom funcionamento das aulas.

e Possui um servico de reprografia de grande dimenséao.

e E responsavel pelo apoio técnico aos utilizadores da FEUPNet, possuindo
também um gabinete de ajuda e esclarecimento de duvidhgsiesk

e Tem disponivel material para producéo de slides e gravacao de CD-ROMs,
mediante marcacao.

e Executa impressodes de varios tipos/qualidades.

e Gere e administra o SIFEUP (ver a proxima secgéo).
e Garante o0 acesso remoto a FEUPNet.

e Fornece listas de distribuic&o via e-mail.

Toda informacé&o acerca dos servicos prestados pelo CICA podera ser encontra-
da na sua pagina web emp:/www.fe.up.pt/cica3w.

5Leitor de correio electrénico no caldo informatico.
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Devido ao crescimento do parque informatico da Faculdade, muitos servicos
tem vindo a ser gradualmente descentralizados do CICA, nomeadamente a disponi-
bilizag&o de salas de PC’s do DEEC, como foi descrito nas secgdes anteriores. No
entanto, todos os alunos da FEUP tém direito a ter uma conta no CICA (no caso das
licenciaturas em Electrotecnia e Informéaticagernamesera o mesmo usado nos
sistemas do DEEC, mas com um password diferente), que Ihe permitira ter acesso
aos servicos do CICA.

4.2.1 Acesso ao correio electronico do CICA
Com a conta do CICA o aluno fica com um endereco de mail da forma:
utilizador@fe.up.pt

Para se poder ver ou enviar correio a partir da conta do CICA pode-se usar o
Netscape depois de correctamente configurado. Para configuietscape
deve-se escolher as seguintes opc@elit« » e «references  » (ver fig.4.4).

File Editlview G0 Communicator

Fie g Fireinolire. f

A

1ame aearch

tions ¢ BizJour

aelect All in Frame  Alt+A
Find in Frame... Alt+F

o q
FeiFilr ANiiser:
UEDILE ftmiiafin:

~

=earch Internet Alt+Shift+F

Freferences... 1

Figura 4.4: Menwpreferences  do Netscape

Depois deve-se escolher a op¢caddad & Newsgroups » que fornece va-
rias escolhas. A primeira coisa a inserir, dentrovtil & Newsgroups , € a
identificagéo (fig4.5).
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JCategory'
I> Appearance Identity Setyour name, email addr nd signature fila
[» Mavigator
7 Mail & Hewsgroups The infarmation below is needed before you can send mail. If you do
Inlentity not know the information requested, please contact your system
Mail Servers administrator or Internet Service Provider.
Mewsgroups Servers Your name:
Adldressing "
Messages Hptoda Sliva
Copies and Folders Email address:
Formnatting
Fieturn Receipts eed877 7@ fe.up.pt
Disk Space A p .
b Foaming Liser Reply-to address (only needed if different from email address):
[> Compaoser
[» Advanced
Organization:
FEUP
Signature File:
rhumefeeSS???If.signature | Choose... |
_| Attach my personal card to messages (as a vCard)  Edit Card... |
Ok Cancel |

Figura 4.5: Formulario para inserir identificacao

OEmail address € o mail que o destinatario vera, e para onde ira responder
caso ndo se preencha o canipeply-to address . A Signature file e
um ficheiro de texto que o Netscape insere automaticamente no fim de um mail
sempre que vamos comecar a escrever um.

Depois de inserir a identificacdo tem que se informar o Netscape sobre o ser-
vidor onde temos o mail. A opcadvail Servers » deve ser seleccionada (fig
4.6). Na segunda secc¢ao onde se defnggoing Mail Server , deve-se es-
crever como servidor: mail.fe.up.pt "e comouser name o login do CI-

CAS.

O «.ocal Mail Directory » € 0 directdrio, na nossa conta local, onde o
Netscape vai colocar as mensagens que queremos guardar e as que acaba de receber.

Voltando ao inicio desta janela, na primeira secggoming Mail Ser-
vers , deve-se adicionao servidor (fig.4.7) com o login correcto.

4.2.2 O SIFEUP

O Sistema de Informac6es da FEUP (SIFEUP) é uma base de dados automatizada
gue permite aos alunos, funcionarios ou professores aceder a numerosas informa-
¢cOes a seu respeito (ou, no caso dos professores, também aceder a informacéao sobre
os alunos). Através da pesquisa pelo SIFEWB (/www.fe.up.pt), poder-se-a en-

Snormalmente este login € igual ao do DEEC
’se ja houver um definido deve-se editar e no adicionar.


http://www.fe.up.pt
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Lalogury
[+ AARARIANEA RMall BeIvers  sipaly saeenrs o meil
Jt Musagalor
o bl MR, Irnznierneng BAi SiHrvHry
Idurilily
bAMl Sareara Add..
ewagrounes gurwery 1 il |
Adlrlranaling
D i To st server prapeties (such as checking far Dielete

Taipilan wriel Calelars e messages autamatie ally, select o server il s e
Furiiatling andl then click Edit, “iH1 A L AHIEN |

Fistirn Macalpts

— - 9
Lily By Stgialng Mall Server

[ Pimaralineyg | laar |
Cauhgurng el (bA T RHrvHE
T — HILTE e D] mallfe g
w Alsriearl - .
i Achvancar Cigtejalng mall server User name. RIS

Use Socure Socket Laver (331 or TLE far autgelng messages.

e MHYHL L (TR [T Ay

— Local mall directary

BEetors | /1 omeracaar? Hnemalls | U

IZIE zancel |

Figura 4.6: Definir Servidores de mail

contrar informacdao referente a qualquer aluno, funcionéario ou professor da FEUP,
Departamentos, Licenciaturas, Mestrados, resultados de inquéritos pedagogicos, e
muita mais informacé&o que € mantida em forma centralizada.

Para ter acesso a algumas das informacgdes € preciso ter um cédigo de acesso.
Por exemplo as fichas de aluno, com informacéo de todas as cadeiras em que es-
ta/esteve inscrito, e as respectivas classificagdes obtidas, bem como a média actual
do curso, pode ser consultada unicamente por docentes ou pelo préprio aluno. Os
cbdigos de acesso podem ser solicitados no CICA; este cédigo permite também al-
terar a informacao que compete alterar a cada utilizador. Os alunos de alguns cursos
podem ja efectuar a sua inscricao nas turmas atravées do SiFEUP.

4.2.3 Acessoremoto a FEUPNet

Existem duas formas de aceder remotamente a FEUPNet, transformando assim o
seu computador de casa huma maquina temporariamente pertencente a rede da Fa-
culdade de Engenharia.

Uma opc¢ao sera assinar o protocolo RCU (Redes de Comunicacao para Univer-
sitarios) da Portugal Telecom que concede pre¢os mais favoraveis nas ligacdes de
dados a rede da FEUP via RDIS. A adesao a este protocolo possui, ho entanto, uma
lista de espera bastante longa, o0 que o torna bastante menos apetecivel.

A segunda opcéo de ligacdo a FEUPNet sera a chamada opgéal, que
consiste em ligar via modem analégico ou placa RDIS para um dos niumeros de
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General POF]

MiHrHD R |'|'|-:I,”,fl:‘.|.||:l.|:|1

TIHFYHT I:.,rle' 1! | |

o0 777

Laer anme,

R T C RN TR E R TTH

FChedk far mall cwary "L filrnte s,

= SalvrmAheAlly disenlin=d =0y s MHE A HE

I, - ance |

Figura 4.7: Definir propriedades do servidor de mail

atendimento de dados do CICA, essa chamada sera dirigida para a maquina que
atende as chamadas dos alunos provenientes das suastcasas.fe.up.pt), e,

tendo o computador propriamente configurado em casa, podera comecar a trabalhar,
guer na rede interna da FEUP, quer na internet, como se estivesse num qualquer
outro terminal da Faculdade ou do DEEC. Para isso basta pedir no CICA (ou através
da pagina wehnttp://www.fe.up.pt/cica3w/formularios/tcpgate.hjroim login na
maquina que atende as chamadas telefénicas (tcpgate).


http://www.fe.up.pt/cica3w/formularios/tcpgate.html
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Capitulo 5

Processamento de texto

Existem duas metodologias diferentes para a producdo de documentos impressos
usando o computador. Os processadores de texto baseados na primeira metodologia,
designada dé/ysiwygWhat you see is what you ggpretendem apresentar no ecra

o documento tal como sera impresso na pagina. A segunda metodologia consiste
na criagcdo de um documento fonte com determinados comandos que apdés serem
processados produzem o documento na forma na qual sera impresso.

Alguns sistema¥Vysiwygdisponiveis em Linux séo o StarOffice, Lyx e Word-
Perfect; na segunda classe de programas os mais usados sédo Tex, LaTeX e Troff.
A primeira vista pode parecer mais facil e rapido usar sistamgswygpor no
precisarem do processamento de nenhum ficheiro fonte, mas na realidade existe
um ficheiro fonte que esta constantemente a ser processado e assim, estes sistemas
costumam ser muito mais lentos, ocupam mais espaco, e dependem de um sistema
operativo em particular. Num sistema como o LaTeX, a criagdo do documento fonte
€ rapida (uma vez se tenha algum conhecimento minimo da sua sintaxe) mas quan-
do o utilizador quer visualizar o ficheiro como sera impresso, o processamento do
documento pode demorar alguns segundos; é de salientar que no ambiente grafico
€ possivel ter duas janelas, uma em modo texto onde se esta a processar o fichei-
ro fonte, e outra em modo grafico que apressenta o ficheiro LaTeX processado, na
forma como sera impresso.

Neste capitulo introduziremos o sistema LaTeX, por acharmos que possui mui-
tas vantagens sobre os sistegssiwyg A primeira vantagem é que em LaTeX o
autor identifica mais facilmente a estrutura légica do documento (divisdo em capi-
tulos, seccdes, etc) sem ser incomodado com pormenores de estética e apresentacao
final do documento (tipos de letra, tamanhos, etc). Nos sistévgasvyg é dificil
manter a consisténcia do documento especialmente quando este tem varias paginas.
Por exemplo, suponha que no texto decide fazer énfase em certas palavras que apa-
recem em linguas estrangeiras ou que definem novos conceitos, usando diferentes
tipos de letra para um caso ou outro; num sistélysiwyg serd a sua respon-
sabilidade lembrar o tipo de letra seleccionado para cada caso; em LaTeX pode
definir um par de comandos com quaisquer nomes coeso e \definicao
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gue usara cada vez que apareca uma palavra em lingua estrangeira ou uma defi-
nicdo: \est{palavra estangeira} \definicao{nome a definir} ;

esta metodologia tem a vantagem de lembrar ao autor do porqué o texto aparece
num tipo diferente de letra; também permite mudar facilmente o tipo de letra usado
por exemplo em todas as palavras estrangeiras que aparegcam no texto. Num sistema
Wysiwygsso implicaria uma revisdo cuidadosa para modificar cada palavra estran-
geira; em LaTeX bastaria uma simples re-definicdo do comaesto no inicio do
documento.

Outra vantagem dos sistemas que trabalham por comandos é que registam a
sequéncia usada para obter determinado resultado, sendo facil de ser copiada e mo-
dificada por outros autores ou pelo proprio autor. Nos sistéiyasvygrealmente
estdo a ser usados comandos cada vez que se carrega num botdo ou menu; mas
a sequéncia de op¢des do menu ou botdes seleccionados que deram origem a um
determinado documento podem ser esquecidos ou dificeis de reproduzir. Um docu-
mento produzido com um sisterésiwyge como uma pintura que pode ser dificil
de copiar por alguém que ndo tenha a mesma pericia do seu autor, e inclusivamente
pelo prépio autor quando ndo estiver no mesmo estado de inspiracdo; seguindo a
mesma analogia, a versdo LaTeX da «pintura» seria uma série de comandos que
ilustram perfeitamente 0s passos seguidos para a sua producéo; copiando um estilo
criado em LaTeX por um artista gréafico, qualquer pessoa pode produzir um livro
com a mesma perfeicdo grafica, sem precisar de ter qualquer talento artstico
criador do documento pode ser até um programa de computador, que utilizando o
mesmo estilo e alterando alguma informacgéo proveniente de uma base de dados,
produz vérios documentos com o mesmo formato grafico e diferentes contetdos.

5.1 Documento tipo

A forma mais facil de aprender LaTeX é olhando para um exemplo simples que
ilustre as principais partes que devera ter um documento. Consideremos um ficheiro
exemplol.tex que contém o seguinte documento LaTeX:

exemplol.tex

\documentclass {article }
\usepackage [ latinl ]{ inputenc }
\begin {document }

\section {Introducdo }

Este € um exemplo simples de um documento
criado usando LaTeX. % este € um comentario
\section {Linhas e paragrafos }

Eis a segunda seccdo do documento.

1Um exemplo de documento criado com LaTeX é este proprio manual.
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O texto sera sempre justificado a direita,
hifenizando palavras se chegar a ser necessério.
Para separar paragrafos serd necessario deixar
pelo menos uma linha em branco.

\end{ document }

Qualquer documento deve aparecer entre os comahdgs{document}
e\end{document} . Antes do inicio do documento é necessario definir o estilo
do documento, por meio do comandocumentclass . Neste exemplo o estilo
usado para o documentoagticle . Outros estilos pré-definidos, usados com
frequéncia, sdo: book, report e letter.

O documento do exemplo tem duas secg¢des («Introdugcéo» e «Linhas e para-
grafos»). Os nomes das seccdes serdo escritos em letra de tamanho maior e em
caracteres negros, seguindo o estilo definido para o documento. A numeracédo das
secc¢oes corresponde ao interpretador do LaTeX, e ndo ao autor, seguindo as normas
no estilo pré-definido.

Alguns caracteres em LaTeX n&o sao interpretados como parte do texto, mas
como uma indicagao para que o interpretador do LaTeX entre em algum modo es-
pecial; por exemplo o simbolo % indica que o0 que vem na continuagao da linha é um
comentario que seraignorado, como no caso do texto que aparece no fim da introdu-
cdo. Os outros caracteres especiais em LaTeX{s§o& # $ _ ~ ~ . Quando
algum caracter especial aparece no ficheiro fonte, ndo é copiado para o ficheiro de
saida, mas é interpretado pelo progrdatax em alguma forma especial. Pa-
ra obter um destes caracteres especiais no ficheiro de saida, devera ser precedido
por uma barra inclinada para a esquergarfo texto impresso desaparece a barra,
ficando unicamente o caracter especial.

O proprio simbold, que acabamos de referir € um pouco mais dificil de obter no
texto: $\backslash$ , mas como nédo é usado com muita frequéncia, foi adopta-
do em LaTeX para indicar os nomes de comandos. Qualquer palavra a comecar por
esse caracter € interpretada como um comando que executa alguma ac¢ao ou define
alguma coisa. O operando (ou operandos) sobre 0 qual actua o comando, costumam
Vvir a seguir ao operador, e dentro dos caracteres especiais: { e }.

O simbolo $ usado acima para produgi® um dos caracteres especiais; tudo
0 que estiver entre dois simbolos $ é interpretado como uma férmula matematica.
Alguns caracteres como as letras gregas ou o proprio «backslash» fazem parte da
tabela de simbolos mateméaticos e nao do alfabeto romano, e por isso € que é preciso
inserir o comando que produz o backslash dentro de dois caracteres $.

O comandd\usepackage[latin1]{inputenc} no inicio do ficheiro é
para permitir o uso de caracteres acentuados no ficheiro fonte.
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5.2 Processamento de ficheiros LaTeX

Uma vez criado um documento LaTeX, como por exemplo o fichkaiesmplo1.tex
na seccao anterior, sera preciso processa-lo para produzir o ficheiro como sera im-
presso. Normalmente sera usado o comando

latex exemplol.tex

para produzir um ficheirexemplo1.dvi que sera logo transformado em comandos
para uma determinada impressora, usando filtros abrips e dvilj . Existem
muitas outras possibilidades, para além da criacéo do fictheirpsegundo o gosto
do autor e o fim ao qual se destina o ficheiro final (Figo®; por exemplo, o
comando

pdflatex exemplol.tex

produz um ficheir@xemplo1.pdf.

@xemplol.ht@e |atex2html <—<exemplol-te><>—> pdflatex {amplol-pdb

latex

exemplol.log exemplol.aux

exemplol.dvi

dvips

exemplol.ps

Figura 5.1: Processamento do ficheiro fogemplo.tex para produzir ficheiros em
formatos PostScript, pdf e html.

Para produzir um ficheirexemplo1.html em formato html, a partir do ficheiro
exemplo].tex, pode usar-se o0 seguinte comando

latex2html -split O -info O -no_subdir exemplol.tex

a opcacsplit 0 € necessaria para que nao sejam separadas as duas seccoes do
documento em dois ficheiros separados (ja que neste caso as sec¢des sao tdo peque-
nas); como ja ndo serdo necessarios botdes de navegacado, pode-se usar também a
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opcaono_navigation para os suprimir. A opcamfo 0O é para suprimir al-
guma informacéo sobre o progratagex2html  que costuma ser incluida no fim
do ficheiro, e a op¢ano_subdir  evita a criacdo de um sub-directOtigemplo
onde normalmente seria colocado o ficheiro resultaxieplol.html. No caso de
documentos mais complexos, com varias secc¢des, o confaed@html  sem
opc¢des produz um sub-directério com varios ficheltsl , que permitem uma
facil navegacao através da secc¢des do documento (em ficheiros separados).
Seja qual for o tipo de ficheiro que se pretende produzir a partir do ficheiro
fonte exemplol.tex, convém sempre usar o comandtex para verificar que o
ficheiro fonte é um ficheiro LaTeX valido (sem erros de sintaxe). Por exemplo,
modifiguemos a linha que digection{Introducao} , ho exemplo 1, para:
\seccao{Introducao} . Quando tentarmos processar o ficheiro fonte com o
comandolatex exemplol  (a extensaotex pode ser omitida), o resultado
sera o seguinte

I Undefined control sequence.
[.5 \seccao

{Introduc™*e30}
?

Este resultado indica que o programa latex identificgeccao , na alinea 5 do
ficheiro, como um comando desconhecido. O sinal de interrogagao corresponde a
gue o programa latex esta a espera de uma decisao por parte do utilizador: abortar,
substituir o comando por outro que esteja correcto, obter uma explicacdo melhor da
causa do erro, etc. Se respondermos com outro sinal de interrogacéo, obteremos a
lista das possiveis ac¢oes:

Type <return> to proceed,

S to scroll future error~messages,

R to run without stopping, Q to run quietly,

| to insert something, E to edit your file,

1 ... or 9 to ignore the next 1 to 9 tokens of input,
H for help, X to quit.

se, por exemplo, respondermos com o comandabteremos a seguinte expli-
cacao:

The control sequence at the end of the top line

of your error message was never \def'ed. If you have
misspelled it (e.g., ‘\hobx’), type ‘I' and the

correct spelling (e.g., ‘\hbox’). Otherwise just
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continue, and I'll forget about whatever was
undefined.

Isto quer dizer que podemos escreivgsection e o ficheiro sera processado
dando origem a um ficheirexemplo1.dvi que pode ser visualizado por exemplo
com oxdvi (ver Capitulo 1). No entanto, o comanidgsection n&o modificara
o ficheiro fonte exemplol.tex, 0 qual continua errado. Para corrigir o ficheiro pode
ser usado o comandoo qual abre um editor de texto (normalmente o edroy
no local onde aconteceu o erro, ou se preferirmos usar outro editor usaremos o co-
mandox para sair do programa latex. Em ambiente grafico um método de trabalho
bastante conveniente consiste em trabalhar com 3 janelas; uma delas tera o ficheiro
fonte dentro dum editor de texto, a segunda terésheilLinux que permita dar o
comanddatex exemplol, e a terceira tera o ficheirexemplol.dvi visualizado
com oxdvi ou outro visualizador de ficheirawi . Quando aparece um erro no
ficheiro fonte, corrige-se o erro no editor de texto, usa-se a seta que aponta para
cima noshell para repetir o ultimo comando (que séatex exemplol ), eo0
resultado pode ser actualizado na janelada , simplesmente com tornar essa
janela activa.

Neste momento podemos referir uma funcionalidade do LaTeX. Suponha que
descobrimos que o comandection  foi repetidamente escrito erroneamente co-
mo seccao ; em vez de corrigir as varias ocorréncias do erro, podemos introduzir
a seguinte definicdo naredmbulo (antes do comandegin{document} ):

\newcommand{\seccao}[1]{\section{#1}}

Assim, definimos o comandgseccao como um sinGnimo d&section ; o ar-
gumento 1 entre parénteses quadrados indica o0 numero de operandos do comando
definido (aquilo que vira a seguir ao nome do comando, entre chaves, quando o co-
mando for usado no texto), e o #1 indica o lugar onde entrara o primeiro operando.

5.3 Outros comandos do LaTeX

Para introduzir outros comandos do LaTeX, vamos apresentar um segundo exemplo
mais complexo, que depois discutiremos em pormenor. O ficheiro fonte do segundo
exemplo é o ficheirexemplo2.tex que se segue

exemplo2.tex

\documentclass [ adpaper , 12pt { article }
\usepackage [ portuges Y babel }
\usepackage [ latinl ]{ inputenc }
\usepackage [dvips ) graphicx }
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\begin {document }

\titte  {Segundo Exemplo }

\author {J. Villate '}

\maketitle

\begin {enumerate }

\item (4 valores) Para medir o coeficiente de
atrito estatico entre um bloco e um disco,
fez-se rodar o disco com uma aceleragdo angular

rad/s constante. O disco parte
do repouso em e no instante S
0 bloco comeca a derrapar sobre o disco.
\begin { enumerate }
\item Desenhe as forgas que actuam sobre o bloco
(visto de cima e de lado).

\item Indique a direccdo e sentido da aceleragéo
do bloco antes de derrapar (visto de cima e de
lado).

\item Calcule o coeficiente de atrito estatico
entre o bloco e o disco
\end{ enumerate }
\begin {center }
\includegraphics {disco.ps}
\end{ center }
\textbf {Resolucdo}. (  \emph{a}) Enquanto o bloco
ndo comecar a derrapar ( cm, constante),
a sua aceleracdo tangencial seréa
\begin {equation }
at= \alpha r = 5\times 8 \; \frac {cm}Hs"2}
= 40 \; \frac {cm}Hs"2}
\end{ equation }
\end{ enumerate }
\end{ document }

O ficheiro obtido depois de processaemplo2.tex COm 0S programalsitex
e dvips aparece na figura.2. Na definicdo do tipo de documento, na primeira
alinea deexemplo2.tex, a lista de palavras entre parénteses quadradossa®s
para o pacotarticle . A opcdoadpaper ¢é para mudar o formato da pagina,
gue por omissdo seria tamanho carta; a okt € para mudar o tamanho da
fonte do texto para 12 pontos (por omissao seria 10 pontos); todas as dimensoes,
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Segundo Exemplo

J. Villate
10 de Setembro de 1999

1. (4 valores) Para medir o coeficiente de atrito estdtico entre um bloco e
um disco, fez-se rodar o disco com uma aceleragio angular a = 5 rad/s?
constante. O disco parte do repouso em t = 0 e no instante t = 0,82 s
o bloco comeca a derrapar sobre o disco.

(a) Desenhe as forgas que actuam sobre o bloco (visto de cima e de
lado).

(b) Indique a direcgdo e sentido da aceleragdo do bloco antes de der-
rapar (visto de cima e de lado).

(c) Calcule o coeficiente de atrito estdtico entre o bloco e o disco

Resolugao. (a) Enquanto o bloco ndo comegar a derrapar (r = 8 cm,
constante), a sua aceleragdo tangencial serd

cm cm

at:ar:5x88—2:40? (1)

Figura 5.2: Verséo final do exemplo 2, obtida a partir do ficheiro fexdsplo2.tex
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como por exemplo o tamanho dos titulos e o espaco entre linhas, serdo aumentadas
proporcionalmente.

Foram introduzidos varios comandos novos no exemplo 2; os comasdes
package no preambulo do documento, sdo usados para carregar pacotes que es-
tendem ou modificam a versao original do LaTeX. O paagtetenc , como ja
vimos no exemplo 1, permite o uso de caracteres acentuados no ficheiro fonte; a op-
cdolatinl dadaao pacoteputenc indica que o cédigo usado para representar
caracteres acentuados € o codggmlatinl. O pacotebabel introduz suporte para
varias linguas dentro do LaTeX; a opgémrtuges(repare que «portuges» nao leva
«U» ja que assim foi definida pelo autor do pacote) faz com que sejam usadas as
regras de hifenizacdo em portugués, e traduz algumas palavras que séo introduzidas
autométicamente pelo prograaéex como, por exemplo, conteudo.

O pacotggraphicx  permite ainsercao de graficos no documento. Neste caso o
ficheiroexemplo2.dvi ndo incluira os graficos, mas sim uma série de comandos para
gue odvips (a opcao usada neste caso) insira os graficos. O pgaplicx
define um comandmcludegraphics , que é usado no exemplo 2 para incluir
um gréafico PostScripti{sco.ps) > como se mostra na figuta2.

O comandanaketitle  cria o titulo do documento, com a informacao defini-
da pelos comandaauthor ,title  edate ; neste caso nao foi usado o comando
date para definir a data, e consequentemente sera usada a data do dia em que seja
processado o ficheirexemplo2.tex, a qual aparecera em portugués, devido ao uso
do pacotebabel . Ca podemos apreciar a filosofia subjacente no LaTeX: o autor
nao tem que se preocupar com 0s pormenores técnicos de como sera escrito o titu-
lo (tamanho e tipo de letra, centrado, etc), mas sim com a sua estrutura logica (o
autor define os campa@aithor etitle e omaketitle  trata do resto). Se esti-
vessemos a produzir directamente um ficheiro cexemplo2.ps na figuras.2, sem
produzir o ficheirexemplo2.tex, um programa de pesquisa ndo conseguia descobrir
gue parte do titulo representa o autor ou titulo, com as consequentes desvantagens.

Para criar listas com numeracao automatica, usaaseliente enumerate; co-
mo qualquer outro ambiente, este deve ter um combhadm e um comandend
gue o delimitam. O inicio de cada alinea na lista é indicado por meio do comando
item ; o inicio de nova linha e a linha em branco antes de cada coni@mdo no
ficheiroexemplo2.tex é simplesmente para facilitar a sua leitura, ndo tendo nenhu-
ma influéncia no aspecto final da lista. No exemplo 2 a primeira lista tem apenas
uma alinea, e dentro dela foi criada uma outra lista que passou a usar uma nume-
racao diferente, nomeadamenteb,.... Se preferir que as alineas de alguma das
listas apresentem um circulo preto em vez de ser numerada, basta trocar o nome do
ambienteenumerate poritemize nobegin eend da respectiva lista.

Como ja tinhamos referido, o simbolo $ é usado para escrever expressdes ma-
tematicas. Dentro das expressdes matematicas o LaTeX usa uma fonte diferente,
semelhante a itadlica mas com diferentes regras de espagcamento e com muitos sim-

2A figura disco.ps foi produzida usando o pacgpsimage
(http://lwww.fe.up.ptivillate/psimage
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bolos matematicos disponiveis. Outra forma de introduzir uma expressdo matemati-
ca é o ambientequation ; nesse caso a expressdo matematica aparecera centrada
e numa linha separada, e com um numero no lado direito que identifica a equacéo
e que é actualizado automaticamente peex . Dentro das expressdes matema-
ticas podem ser usados subindices e superindices por meio dos simedio®
caracter imediatamente a seguir ao simbolo sera o subindice ou superindice. Para
escrever indices com mais do que um caracter sera preciso usar chaves como por
exemplo:10M12} , o qual produzird0'2. O comanddrac ¢ usado dentro do
modo matematico para produzir frac¢des; este comando tem dois operandos (nume-
rador e denominador). O comando é usado no modo matematico para introduzir
um pequeno espaco.

Outro ambiente usado no exemplo 2 € o ambieetger para centrar texto
ou qualquer outro objecto. O coman@atbf define texto em caracterasgros
e o comand@mph define caracteratalicos.

5.4 Graficos vectoriais usandxfig

Uma ferramenta Gtil para desenhar diagramas para um documento € o programa
xfig . O programaxfig cria graficosvectoriais®, num formato préprio e com
nomes de ficheiro com terminacéflg; o programa permite também exportar o
grafico para outros formatos vectoriais lmtmap ou para uma série de comandos

do LaTeX que podem ser introduzidos directamente num ficheiro LaTeX.

O primeiro passo que devera ser feito € abrifig com algumas opc¢des para
reduzir o seu tamanho, ja que tal como vem configurado serd impossivel de vi-
sualizar a janela completa, a menos que trabalhe com um ecra de alta resolucéo
(1280 x 1024 ou superior). Umas opc¢des apropriadas para resolucdes graficas de
800 x 600 ou 1024 x 768 s&o as seguintes

xfig -but_per_row 3 -pheight 15 -pwidth 20 &

A opcaobut_per_row aumenta a largura da area de botbes na esquerda (figu-
ra5.3), e as opcdepheight e pwidth modificam as dimensdes (em centime-
tros) da area de trabalho a direitaxfly pode ter sido compilado com o uso de
polegadas em vez de centimetros, e nesse caso sera necessaria @eificao
para mudar para centimetros.

A figura 5.3 mostra a janela dafig , quando for executado com as opc¢des
sugeridas acima. A janela est4 dividida em 4 secc¢des. A primeira seccao € a barra
horizontal superior com menus, uma linha com informacéo sobre o objecto que se

3Gréficos nos quais cada curva ou area séo definidas em forma matemaética em fungéo de coor-
denadas de pontos em duas dimens8es. A qualidade dos gréficos vectoriais permanece igual quando
a figura for ampliada ou reduzida, o qual ndo acontece nos gréaitcasp.
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Figura 5.3: O programxfig

esta a desenhar, e um quadro a direita que mostra os trés botdes do rato e a sua
funcdo. A segunda seccdo, a esquerda, sdo os botdes para seleccdo de modos; os
modos estdo divididos em modos de deseminawing model usados para dese-

nhar curvas ou poligonos, escrever texto, ou incluir imagens externas ou imagens
existentes na biblioteca de imagensxdig , e modos de edicaediting modeks

gue permitem combinar objectos para formar um objecto composto, ou modificar

0S objectos ja existentes. A terceira sec¢ao € a area de trabalho a direita dos botdes,
e a quarta area é a zona de op¢des do modo que estiver a ser usado.

No exemplo da figura, esta a ser usado o modo «PolyLine» para desenhar li-
nhas quebradas, o qual aparece sublinhado na area de botées de desenho. A linha
de informacéo por baixo do menu indica que tém sido usados 2 pontos na ultima
linha poligonal desenhada (parte da porta da casa) e que o0 ponto onde se encon-
tra o cursor esta deslocado 1,2 cm na horizontal e 0 cm na vertical, em relacdo
ao ponto anterior (ponto numero 2); é de salientar que os deslocamentos verticais
sdo medidos de cima para baixo xig E importante também observar a in-
formag&o no quadro com os trés botdes do rato; este indica que se carregarmos no
botdo esquerdo, fixaremos a posi¢ao do terceiro ponto, passando para o quarto pon-
to, se carregarmos no botdo do centro finalizaremos a linha poligonal que estamos
a desenhar, e se carregarmos no botao direito eliminaremos a linha poligonal que
estavamos a desenhar, podendo comecar uma nova. A outra rea que € importante
observar, antes de comecar a desenhar um objecto, € a seccao de opc¢des por baixo
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da area de trabalho. Na figusa3 aparecem as op¢des com que esta a ser usado o
modo «PolyLine»: espessura e estilo da linha, resolugcao da posicdo onde pode ser
descolado o cursor, etc. Carregando duas vezes no botdo de alguma opc¢éao, aprece
um menu que permite a sua modificagao.

Para aprender ausaxfig € preciso experimentar bastante com os seus modos
e opcoes. Se tiver seleccionada a opcao de «Balloons», na parte superior da janela,
guando deslocar o rato por cima de um botdo ou menu obtera alguma informacéo
sobre a sua fungéo e, no caso dos menus, aparecera indicado o uso dos diferentes
botbes do rato.

5.5 Outras fontes de informacao

Neste capitulo temos falado de uma pequena parte das potencialidades do LaTeX
gue esperamos sejam suficientes para comecar a usa-lo. Para obter uma visdo mais
completa, existem varios livros sobre o Latex; alguns deles sao livres e podem ser
obtidos em fomato tex, dvi, ps ou pdf. As distribuicées de Tex/Latex costumam vir
com bastante documentacéo; na distribuicdo Debian, a documentacéo encontra-se
no directorio/usr/doc/latex, 0 qual contém também paginas étml com aponta-

dores para a documentacgao.

Sendo o LaTeX um esforgo conjunto de muitos voluntarios existe também uma
rede de servidores dedicados exclusivamente a receber as contribuicdes do publico
(pacotes e documentacao), designadosudgiivos CTAN (Comprehensive TeX
Archive Network existem varios servidores da CTAN espalhados pelo mundo, com
0 mesmo conteudo, embora os métodos de acesso possam ser diferentes. Alguns
nodos da CTAN na Europa sao os seguintes

http://ftp.rediris.es/
http://ftp.tex.ac.uk/
http://ftp.dante.de/
http://ftp.univie.ac.at/

Grande parte da documentacédo incluida com programas para Linux tem sido
feita usando LaTeX; consequentemente, uma boa fonte para aprender LaTeX con-
siste em estudar os ficheiros fonte de algum manual que tenha alguma caracteristica
gue deseje imitar nos seus documentos. O rapido crescimento de sistemas livres
como o LaTeX é devido a liberdade de distribuir e copiar informacéo entre autores
e utilizadores.
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Apéndice A

Glossario de Informatica e Redes

Neste apéndice aparece uma lista parcial de termos de informatica. Alguns destes
termos foram usados neste manual, e outros ndo mas séo incluidos cé por aparece-
rem frequentemente nos temas relacionados com o manual.

A

API (Application Programming Interface). Rotinas usadas para requisitar ac¢oes
de baixo nivel ao sistema operativo. Usado no desenvolvimento de aplica-
coes.

APM (Advanced Power Management).Recurso para economia de energia.

ASCII. tabela de simbolos, usada para gerar e armazenar os codigos que nao po-
dem ser criados via teclado. Foi definida pela ANSI.

Auto-estrada da informacao / auto-estrada electronicaUma ligac&o ou conjun-
to de ligacdes entre computadores, formando uma rede de redes, de preferén-
cia com meios de comunicacao extremamente rapidos. Um nome abusiva-
mente usado por vezes (sobretudo nos media tradicionais) para designar a(s)
rede(s) actualmente existente(s) (e em particular a Internet), pois uma grande
parte delas ainda tem muitas ligacOes bastante lentas.

B

Backup. copia de seguranca dos ficheiros de um computador.

Bauds (ou bps). velocidade de comunicacao (portas série ou portas paralelas). E-
xemplo: modem de 28.800 bauds.

BBS (Bouletin Board System).sistema de comunicacao, usado para comunicacao
e troca de informagfes. Foi substituido em grande parte pela Internet, que
possui melhor operacionalidade.
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BIOS (Basic Input Output System). sistema existente nos PC’s que permite a con-
figuracdo e armazenamento das caracteristicas de hardware do computador.

Bit. quantidade minima de informacédo. Genericamente é representado por 0 ou 1.
Boot. inicializagdo do computador.

Boot record. registo de inicializacdo, parte do disco rigido que contém a iniciali-
zacao do sistema operativo.

Byte. a unidade de medida da informacéo (8 bits). Equivale basicamente a um
caracter.

Browser. programa que ajuda na navegacao pela WWW. Um browser ajuda o uti-
lizador a encontrar e obter a informacé&o desejada. O Netscape Navigator e 0
Internet Explorer sédo os browsers mais comuns.

Buffer. memodria intermediaria auxiliar, que facilita as tarefas, pois liberta o pro-
cessador.

Bug. erro escondido num programa (erro de programacao).

Bus. condutores eléctricos dentro do computador (estradas por onde os dados se-
guem).

C

Cache. memoria auxiliar que facilita a recuperacao de informac¢des recentemen-
te/frequentemente acedidas.

CAD / Computer Aided Design (Projecto Assistido por Computador) programas
usados para projectos de engenharia, de arquitectura e cientificos — constru-
cao de automoveis, avioes, edificios, etc.

CD-ROM. discos compactos laser, que contém informacédo (dados, sons, musica)
gue podem ser lidos, mas nao alterados e nem re-gravados.

Chip. designacao de circuito integrado, que inclui desde dezenas a milhares de
circuitos electronicos em si.

Ciberespaco. por ciberespaco designa-se habitualmente o conjunto das redes de
computadores interligadas e de toda a actividade ai existente. E uma espécie
de planeta virtual, onde as pessoas (a sociedade da informacgao) se relacionam
virtualmente, por meios electrénicos. Termo inventado por William Gibson
no seu romance Neuromancer.
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Client / cliente / estacao de trabalho.computador que acede aos recursos parti-
Ihados de rede fornecidos por outro computador.

CMYK. sistema de cores usado para impressao — qualquer tom de cor pode ser
gerado usando a combinacdo CMYK (ciano, magenta, amarelo e preto).

Compactacao / Compressaocompactar os dados para ocupar menos espago de
armazenamento ou menos tempo para o envio/recepg¢éao do arquivo. Os pro-
gramas mais usados em Linux para compactar e des-compactar sédo gzip, zip,
unzip e compress.

Compilador. programa que transforma uma lista de comandos em forma de textos
(legivel) para a forma de linguagem de maquina, que somente o computador
identifica e usa para execucdo. O computador ndo executa directamente 0s
comandos em forma de texto.

Correio electrénico. ver e-mail.
CPU. parte principal do computador (processador e registos internos).

Criptografia. sistema de seguranca, que transforma matematicamente um ficheiro
em simbolos, que apenas podera ser de-codificado por alguém que tiver a
tabela ou férmula de de-criptografia especifica para aquele ficheiro.

Cursor. sinal no écran (geralmente estatico ou a piscar) que nos indica onde no
écran deve ser inserida a préoxima informacéo (pode ser alterado com o0 uso
do teclado ou do rato).

D

Default / valor padréo. um programa pede uma informacéao e oferece uma respos-
ta padrdo (mais comum). Se nao altera, assume este valor default.

Desktop. area de trabalho do écran — espaco visual do écran.

DMA (direct memory access) / acesso directo a memoriaa informacéao é trans-
ferida entre a memoria e o disco rigido, sem passar pelo processador — o
mais rapido. Usado por alguns aplicativos.

Dominio. nome de uma rede de computadores com a ultima parte do endereco IP
comum. Ao ultimo termo de um dominio chama-se dominio de topo. Cada
pais tem um dominio de topo. Por exemplo:

e au - Australia

e ca- Canada
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e de - Alemanha

e es - Espanha

e fr - Franca

¢ nl - Holanda

e no - Noruega

e pt- Portugal

e se - Suécia

e Uk - Reino Unido

e Mz - Mogcambique

e br - Brasil
Se o dominio de topo néo for um codigo de um pais, é bastante provavel que
o0 pais seja os E.U.A. (embora hoje em dia outros paises tenham comec¢ado a
usar os mesmos dominios). Os dominios de topo americanos sao:

e COmM - organizacdes comerciais

e edu - instituicbes de ensino / educacao

e gov - organizacdes governamentais

e Mmil - organizacdes militares

e net - fornecedores de servicos Internet

e 0rg - organizacdes sem fins lucrativos

Dominio publico. algo que esta no dominio publico (software, p.ex.) é algo que se

pode copiar, cortar, colar, queimar, distribuir, deitar ao lixo e nomeadamente

utilizar sem pagar o que quer que seja! Nao confundir c@@ofowvarelivre!
(ver Freeware)

Driver. programa (software) que controla um dispositivo de hardware.

E

EISA (Enhanced Industry Standard Architecture). padrao de barramento inter-
no dos computadores, superior ao ISA.

E-mail / electronic mail / correio electrénico. correio transmitido por meios elec-
tronicos, normalmente redes informaticas. Uma carta electronica contém tex-
to (como qualquer outra carta) e pode ter sons, imagens ou outros documentos
anexos.

Endereco. ver site.
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EPS (Encapsulated PostScript).Ver PostScript.

F

FAQ (Frequently Asked Questions) / Perguntas Feitas Frequentementsolucao
para as davidas mais comuns (relacao de perguntas e respostas ja feitas).

Fila de impresséao / spool.programa que controla a fila de impressédo. Quem envi-
ou tarefas para imprimir primeiro, prioridades, etc.

Fontes. tipos de letras instalados no computador.

Formatar. dividir um disco rigido ou flexivel em sectores, para possibilitar o ar-
mazenamento das informacoes.

Forum de discussao.ver newsgroup.

Freeware. termo que costuma ser mal interpretado, devido ao duplo sentido da pa-
lavraFree Neste caséreedeve ser traduzida como livre e ndo como gratis.
O Software Livrepode ser vendido ou distribuido gratuitamente, modificado
e redistribuido, mas em todos os casos existem leis que o protegem para im-
pedir que alguém tome controlo sobre ele. Nomeadamente, se for vendido
por uma companhia, esta esta obrigada a distribuir também o codigo fonte
gue permite a qualquer outro modifica-lo, copiar e até re-vender. Um progra-
ma livre ndo deve ser confundido com programas do dominio publico, pois
no caso do dominio publico alguém pode fazer com que as fontes desapare-
¢cam e continuar a distribuir binarios sendo o Unico em poder das fontes; isso
seria ilegal no caso dbreeware O Linux e a maior parte dos programas
distribuidos com ele s&ereeware

FTP (File Transfer Protocol). método de transferéncia de dados entre computa-
dores.

Full-duplex. quando a informacéo circula em ambas as direccbes pela linha de
dados. Por exemplo: ao conversar na Internet, se tivermos uma placa de som
full-duplex poderemos falar e ouvir ao mesmo tempo.

G

Gateway. porta de comunicacao.

GIF. formato proprietario para ficheiros de formato grafico. Por usar unicamente 8
bits por ponto e permitir compactacao, produz ficheiros de pequenas dimen-
sOes, mas nao permite usar mais do que 256 cores.
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Grupo de news. ver newsgroup.

GUI (Graphical User Interface). maneira grafica de lidar com os aplicativos. O
X € uma interface grafica.

H

Hard Disk. disco rigido interno do computador usado para armazenar permanen-
temente as informacgdes.

Hardware. conjunto de material que constitui ou esta integrado num dado compu-
tador, € a sua parte fisica.

Hidden/ escondido. ficheiro que existe fisicamente, mas nao esta visivel; em Unix/
Linux o primeiro caracter no seu nome devera ser um ponto.

Homepage. pode ser a pagina web carregada automaticamente pelo browser quan-
do arranca, ou ser a péagina principal de um conjunto de paginas dedicadas
a um assunto. Costuma conter uma mistura de graficos e texto, assim como
referéncias (hyperlinks) para paginas com ela relacionadas.

Host. ver servidor.

Hypertexto (hypertext). Formato que permite que a informagéo seja organizada
num formato ndo sequencial, e acessivel através de ligacdes directas (links).
Deste modo, o hypertexto permite aos utilizadores o acesso a informacao a
partir de multiplos pontos de entrada. Dois sistemas de hypertexto usados em
Linux s&o a linguagerhtml| e o sistemanfo

icone. simbolo gréfico (pequena figura) que é uma maneira rapida de executar uma
accao (exemplo, clique no icone da impressora para imprimir).

IDE. sistema de troca de dados do disco rigido para a placa controladora do micro-
computador, o mais usado. Existem sistemas mais rapidos, como o Fast-IDE
(Fast-ATA) ou SCSI (tecnologia bem diferente, voltada para multiprocessa-
mento - redes, ou scanners, CD ROMS).

Importar. trazer dados, informacdes de outro programa.

internet. com i mindsculo, internet designa apenas uma rede de redes e nao espe-
cificamente a Internet.



e

Internet. a melhor demonstracéo real do que € uma auto-estrada da informacéo.
A Internet (com | maidsculo) é uma imensa rede de redes que se estende por

todo o planeta e practicamente todos os paises, possibilitando diversos tipos
de servigos informaticos.

ISP (Internet Service Provider). fornecedor de servi¢os de internet — a empresa
que nos fornece acesso a Internet.

Intranet. rede interna de informag¢des numa empresa, que usa o mesmo formato de
armazenamento e busca de informagdes da Internet. Usada como forma de
comunicacao e divulgacédo de informacdes internas numa empresa.

IP / endereco IP. endereco Internet Protocol, usado para especificar as rotas de co-
municacao.

IRQ/interrupgao (Interrupt Request Lines). endereco fisico no hardware do com-
putador. Alguns dispositivos/placas internas do computador usam nimeros de
interrupcao para indicar ao processador o seu estado. Dentro do microcom-

putador, geralmente, cada dispositivo deve ter uma interrupgao diferente, para
gue nao haja conflitos.

ISO (International Organization for Standardization). organizagéo que estabe-

lece normas de qualidade a nivel mundial. Normas de procedimento/ padro-
nizagao.

J

JAVA. linguagem de programacéo que também pode ser utilizada para produzir
paginas Internet, com mais recursos que a linguagem HTML.

JPEG, JPG. extensao para ficheiros de formato gréafico, em que os ficheiros podem
ser compactados a varios niveis, chegando a ocupar espaco muito reduzido;
parte da informacédo € perdida conforme o grau de compacta¢do, mas nas

imagens fotograficas a qualidade é possivel manter uma alta qualidade com
alto grau de compactacao.

Jumper. pequenos interruptores de plastico usados nas placas de hardware. Por ou

tirar um jumper, significa mudar a operagéo das placas. Sistema de configu-
racao das placas.

K

Kernel. a parte do sistema operativo que gere o processador.
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Keyboard. teclado.

L

LAN (Local Area Network). ligacdo de computadores em rede, atraves de cabos
fisicos.

Laptop. computador portatil. Os notebooks e subnotebooks sao ainda menores que
os laptops.

LCD (Liquid Crystal Display). écran de cristal liquido utilizado em alguns mo-
delos de computadores portéateis.

Link. na Web, uma palavra destacada indica a existéncia de um link, que é uma
espécie de apontador para outra fonte de informacéo, uma espécie de elo de
ligacdo. Escolhendo esse link, obtém-se a pagina de informacéo que ele de-
signava que pode, por sua vez, ter também varios links.

Linux. Sistema operativo livre, criado por Linus Torvalds mas actualmente desen-
volvido por um grupo aberto de voluntarios no mundo inteiro. Inicialmente
criado como versao compativel do Unix para computadores PC, mas hoje em
dia existem versfes para muitas plataformas e workstations-re@ware)

Login / Logon. identificacdo de um utilizador perante um computador. Fazer o
login (ou logon) é o acto de dar a identificagéo de utilizador ao computador.

Logout. acto de desconectar a sua ligacao a um determinado sistema ou computa-
dor, finalizac&o do acesso ao sistema.

M

Macro. sequéncia de comandos (pequeno programa) para automatizar procedi-
mentos.

Maquina de pesquisa.ver search engine.

MBR (Master Boot record) / registo de inicializacdo. parte do disco rigido que
contém a inicializacdo do sistema operativo. Em Linux o MBR pode ser
alterado por meio do prograntido , para dar a possibilidade de arrancar o
computador em diferentes sistemas operativos.

Modem (modulador/des-modulador de sinais).aparelho que permite comunica-
¢cao entre computadores.

Motores de procura. ver search engine.
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Mouse / Rato. dispositivo que auxilia no manuseio do sistema, principalmente em
sistemas graficos. O movimento que faz com o rato, é reflectido no écran.
Indispensavel auxiliar do teclado.

MS-DOS. sistema operativo da Microsoft, prévio ao aparecimento do Windows
95.

Multimédia. presenca de varios tipos de informacéao (texto, imagens, audio, video,
etc.) no mesmo suporte.

N

Navegar. na Internet significa vaguear, passear, procurar informacéo, sobretudo na
Web.

net. ver rede.
Net. Net (com N mailsculo) é uma abreviatura para designar a Internet.

Netiquette. conjunto de regras e conselhos para uma boa utilizacéo da rede Inter-
net, de modo a se evitarem erros proprios de novatos aquando da interac¢ao
com outros utilizadores (mais experientes). A netiquette baseia-se muito no
simples e elementar bom senso.

Netscape.nome de um dos mais comuns browsers da Internet, € também o nome
da empresa que o fabrica.

Network. chama-se network sempre que se interligam dois computadores ou mais
de forma a constituirem uma rede e portante capazes de partilhar recursos.
Ligando duas ou mais networks forma-se uma internet (com inicial mindscu-
la).

News. ver newsgroup.

Newsgroup. séo grupos de discusséo, organizados por temas, onde se pode ler e
escrever (publicamente) sobre o tema indicado pelo nome do grupo de dis-
Cusséao.

O

Offline. quando o computador ndo tem ligacao a rede, esta offline.

Online. por oposicdo a offline, online significa "estar em linha", estar ligado em
determinado momento a rede ou a um outro computador. Para alguém, "estar
online", significa que nesse momento essa pessoa esteja a usar a Internet e
gue tenha, portanto, efectuado o login num determinado computador da rede.
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P

Pagina WEB ou WWW. ver homepage.
Palavra-chave. ver password.

Parametro. uma variavel que é passada para um programa ou rotina (parte de um
programa).

Particdo. divisdo l6gica de um disco rigido, de forma que parecam existir varias
unidades fisicas distintas. Em Linux o primeiro disco mestre encontra-se
dividido nas particdeglev/hdal, /dev/hda2,. .., o primeiro disco escravo tem
as particdegdev/hdbl, /dev/hdb2,. . ., etc.

Password. cédigo usado para aceder a um sistema fechado, senha de acesso.

PC (Personal Computer). computador pessoal; termo geralmente usado para com-
putadores com a arquitectura dos modelos IBM-PC, baseados em micro-
processadores Intel 286/386/486/Pentium, e compativeis.

PCI (Peripheral Component Interconnect). barramento que sucedeu ao Vesa Lo-
cal Bus. Utilizado na maioria dos computadores Pentium.

PCMCIA (Peripheral Computer Memory Card International Association) dis-
positivos de hardware em forma de pequenos cartées. Em geral, usado para
computacao portétil (laptops e notebooks). Exemplo: cartdes PCMCIA de
memoria, fax/modem, de rede, etc.

PDF (Portable Document Format). formato usado para representar documentos;
um ficheiro pdf pode conter varias paginas, e cada pagina pode ter uma com-
binacdo de texto e imagens com um formato que sera independente do dis-
positivo e resolucéo usados para imprimir ou visualizar. Também permite a
criacao de hypertextos.

Pentium. processador mais avancado, actualmente, para a linha de PC’s.

Pixel. o menor ponto do écran o dispositivo grafico. O écran é dividido em milhares
de pontos. A resolucao do écran pode ser configurado pelo utilizador.

Plataforma. o tipo de computador, processador, sistema operativo em uso. Exem-
plo: Este programa funciona somente em plataforma PC-Linux. Ou, funciona
em plataforma Macintosh, RISC-Unix, PC-MSWindows, SPARC-Linux, etc.

PNG. formato gréafico criado para substituir gd . Permite também diferentes
graus de compactacdo sem perda da qualidade, mas usa um algoritmo de
compactacgéao livre de patentes, e permite usar muitas mais cores do que as
256 do formatagif .



81

Portas série. portas usadas para ligar ratos, modems, etc. Encontram-se normal-
mente emidev/ttySO0, . .. ,/dev/ttyS3. Os bytes sdo enviados em fila pela porta
série, uns atras dos outros.

Portas paralelas. portas usadas para ligar impressoras, algumas camaras de video,
etc. Encontram-se normalmente edev/Ip0, ..., /dev/Ipl. Os bytes s&o
enviados de 8 em 8 (em geral) pela porta paralela, tornando a comunicacgéo
paralela bem mais rapida que a série.

PostScript. Linguagem da Adobe para criacdo de graficos vectoriais, inicialmen-
te para impressoras, que se tem convertido num padrdo. O programa livre
GhostScripg uma implementacao d@stScriptcom algumas extensoes.

PPP (Point-to-Point Protocol). protocolo (método) usado para comunicacao entre
computadores, em geral na Internet e usando modem.

Proxy. computador intermediario numa ligacao, recebe os pedidos de uma rede e
da-lhes seguimento.

Public domain. ver dominio publico.

Q

Query. Consulta / pesquisa.

Quit / sair. finalizar o uso de um programa.

R

RAM (Random Access Memory). meméria principal temporaria do computador.
E esvaziada quando desligamos o computador.

Realidade virtual. simulacdo do mundo real (visdo, som, sensacoes tacteis, etc.)
por processos inteiramente controlados através de meios electronicos.

Rede. conjunto de computadores ligados por forma a serem capazes de comunicar
entre si.

Reset/ Reboot.reinicializar o computador. A combinagé&o de teclas: Ctrl+Alt+Del
pode estar configurada para fazeRebootou o Shutdown O botdo de reset
nao deve ser usado em Linux, sem antes ter feitd@Stntdown (ver Shut-
down

Resolucdo.a qualidade da placa de video, do monitor de video ou da impressora,
guanto ao numero de pontos (pixels) que pode apresentar.
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ROM (Read Only Memory) / Memaria S6 de Leitura. memaria ndo volatil (per-
manece quando computador é desligado). Sé de leitura, ndo pode ser alterada
pelo utilizador. A BIOS é gravada em ROM. Os dados configuraveis da BIOS
em EPROM.

Router. computador, software ou material dedicado que serve para interligar duas
ou mais redes efectuando automaticamente a re-direc¢ao correcta dos pacotes
de informacgé&o de uma rede para outra.

RS-232. sistema de comunicac¢ao série.

S

Scanner. dispositivo que transporta imagens do papel para a memoria do compu-
tador.

Script. conjunto de comandos ou programa que € interpretado sem ter que ser com-
pilado.

Search engine.ferramenta de software usada na pesquisa de servidores na Internet
com paginas relativas a um determinado tema ou que incluiam determinadas
palavras.

Server / Servidor. 0 computador que administra e disponibiliza recursos na rede,
partilhando software e os seus ficheiros com os utilizadores, que acedem a
partir das estacdes ou de seus computadores remotos.

Sector. divisdo (gavetas) de armazenamento nos discos (rigidos e flexiveis).

Shareware. software que € distribuido gratuitamente mas néo livremente (o cédigo
fonte ndo é distribuido). Normalmente, foi feito para ser testado durante um
curto periodo de tempo e, caso seja utilizado, o utilizador deve regista-lo.

Shell. A interface do sistema operativo.

Shutdown. finalizar todas as aplicacdes, gravar os dados que estdo na memoria a
fim de poder desligar com seguranca o computador. Nunca desligue o com-
putador sem ter feito primeiro o shutdown; os programas e dados activos na
memoria, serdo perdidos e o disco rigido pode ser danificado. A combinacao
de teclas: Ctrl+Alt+Del pode estar configurada para faz8hotdowrou o
Reboot (verResel)

Sintaxe. forma e ordem na qual os comandos e elementos devem ser digitados.

Sistema Operativo. sistema (programa) que faz comunicacao entre o hardware e
os demais softwares. Exemplo: Linux, Windows95, WindowsNT, etc.
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Site. local; diz-se da pagina de uma empresa ou pessoa. E um dos computadores
da Internet ou o caminho até uma das paginas existentes nesse computador.

SLIP (Serial Line IP). protocolo (método) usado para comunica¢ao entre compu-
tadores usando a porta série, em geral na Internet.

Smile / smiley. sdo pequenos conjuntos de caracteres utilizados em correio electré-
nico e foruns de discusséo que pretendem transmitir uma emocéao ou estado
de espirito. Os mais conhecidos séo:

e :-) OU :)  -sorriso, estou a brincar.
e ;-) OU ;) - piscar de olho.

e -( ou :(  -triste, carrancudo.

e -* - Deijo.

e :-P ou P - caretas (p6r lingua de fora).

SMTP (Simple Mail Transport Protocol). protocolo de transmissédo de ficheiros
via correio electronico.

Snail mail. referéncia ir6nica ao correio postar (snail = caracol), comparando-o
com a celeridade do e-mail.

Software. conjunto de programas que corre, ou esti preparado para correr, num
dado computador.

Software Livre. verFreeware

Spam. publicacdo do mesmo artigo de news em varios grupos de discussao ou
envio exagerado de varios mails, geralmente para utilizadores que néo o soli-
citaram, geralmente resultando em desperdicio de espaco em disco e largura
de banda nos meios de transmisséo.

Spooler. programa que controla a fila de impressdo. Quem enviou tarefas para
imprimir primeiro, prioridades, etc.

Swap. Area de um disco rigido que é destinada & emulagdo da memaria RAM.
Uma area de swap permite a um sistema funcionar como se tivesse mais me-
moria RAM, mas o seu uso torna o sistema mais lento, pois o processador
gue transferir transferir partes da meméria swap para a memoéria RAM fisica
cada vez que precisar ter acesso a ela.

T

TCP/IP (Transmission Control Protocol / Internet Protocol). protocolo (método)
de comunicacgao entre computadores.
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Telnet. programa que permite trabalhar num computador remoto ligado a Internet
como se estivéssemos frente a um terminal fisicamente ligado a esse compu-
tador.

Tempo médio de acessotermo que se refere ao tempo de resposta médio que um
dispositivo leva para aceder a informacao. Exemplo: memoria de 60 ns, disco
rigido de 13 ms.

Time-out. sinal que um dispositivo emite quando chegou o tempo limite no qual
estava a espera de receber uma informacéo.

Topologia. disposi¢cado e modo de ligacdo dos computadores numa rede (em estrela,
em anel, etc.).

U

Unix. sistema operativo com caracteristicas de multi-tarefa; os primeiros computa-
dores ligados a Internet usavam este sistema exclusivamente. O Linux é um
sistema operativo criado para ser compativel com o Unix, mas que por nao
ser comercial ndo tem obtido o selo de aprovacdo da empresa que mantém os
direitos sobre a marca registada Unix.

UPS (Uninterruptible Power Supply). fonte de alimentacgao ininterrupta; sistema
com baterias, que mantém o computador a funcionar por um determinado
periodo.

URL (Uniform Resource Locator). ver site.

USB (Universal Serial Bus). sistema de comunicac¢ao série, que permite a ligacao
de diversos periféricos.

Username. ver login.

V

Virtual Reality. ver realidade virtual.

W

Web. diminutivo para World Wide Web (a semelhanca de WWW ou W3).

Webmaster. criador/responsével por paginas ou sites na Internet (paginas Web).
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Windows (3.1, 95, NT etc).sistemas operativos da Microsoft.

World Wide Web. subconjunto da Internet, em que a informacao é organizada em

documentos multimédia interligados por hyperlinks.

WWW. ver Web.

WYSIWYG (What You See Is What Get). "O que vé é o que tera"; o que vé no

écran, terq exactamente o mesmo aspecto na impressora.

X

X. Sistema gréfico de janelas que pode ser executado em plataformas Unix e com-

Y2K.

Zip.

pativeis. Esta dividido em duas partes: cliente e servidor, que podem ser dois
computadores diferentes e inclusivamente com sistemas operativos diferen-
tes. O servidor recebe a entrada dos programas do cliente e envia para eles a
saida.

Y

sigla referente ao problema de transicdo do ano 2000 nos sistemas informa-
ticos, o "bug do ano 2000".

Z

Formato usado para criar arquivos de ficheiros comprimidos. Um arquivo Zip
costuma ter um nome terminado efip. Podem ser criados usando o progra-
mazip , e para extrair e descomprimir ficheiros pode ser usado o programa
unzip .
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